© 2009 ZIH Corp. The copyrights in this manual and the software and/or firmware in the printer described therein are owned by ZIH Corp. and Zebra’s licensors. Unauthorized reproduction of this manual or the software and/or firmware in the printer may result in imprisonment of up to one year and fines of up to $10,000 (17 U.S.C.506). Copyright violators may be subject to civil liability.

This product may contain ZPL®, ZPL II®, and ZebraLink™ programs; Element Energy Equalizer™ Circuit; E³™; and Monotype Imaging fonts. Software © ZIH Corp. All rights reserved worldwide.

ZebraLink, Element Energy Equalizer, E³ and all product names and numbers are trademarks, and Zebra, the Zebra head graphic, ZPL and ZPL II, and BAR-ONE are registered trademarks of ZIH Corp. All rights reserved worldwide.

mySAP™ is the trademark or registered trademark of SAP AG in Germany and in several other countries. All other brand names, product names, or trademarks belong to their respective holders.

All other brand names, product names, or trademarks belong to their respective holders. For additional trademark information, please see “Trademarks” on the product CD.

Proprietary Statement This manual contains proprietary information of Zebra Technologies Corporation and its subsidiaries (“Zebra Technologies”). It is intended solely for the information and use of parties operating and maintaining the equipment described herein. Such proprietary information may not be used, reproduced, or disclosed to any other parties for any other purpose without the express, written permission of Zebra Technologies Corporation.

Product Improvements Continuous improvement of products is a policy of Zebra Technologies Corporation. All specifications and designs are subject to change without notice.

Liability Disclaimer Zebra Technologies Corporation takes steps to ensure that its published Engineering specifications and manuals are correct; however, errors do occur. Zebra Technologies Corporation reserves the right to correct any such errors and disclaims liability resulting therefrom.

Limitation of Liability In no event shall Zebra Technologies Corporation or anyone else involved in the creation, production, or delivery of the accompanying product (including hardware and software) be liable for any damages whatsoever (including, without limitation, consequential damages including loss of business profits, business interruption, or loss of business information) arising out of the use of, the results of use of, or inability to use such product, even if Zebra Technologies Corporation has been advised of the possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.
# Contents

- **Contents** ........................................................................................................... 3

- **1 • Introduction** ............................................................................................... 7
  - Welcome .................................................................................................................. 8
  - Contents of the package ..................................................................................... 8
  - About this Manual .............................................................................................. 9
    - About this Manual .......................................................................................... 9
    - Typographical Conventions ......................................................................... 9

- **2 • Installation and Activation** ......................................................................... 11
  - System and Software Requirements ................................................................ 12
  - ZebraDesigner for mySAP .............................................................................. 12
  - Install ZebraDesigner for mySAP .................................................................. 12
    - Install Overview for ZebraDesigner for mySAP ........................................ 12
  - Close All Software Applications .................................................................. 12
  - Run Installation ................................................................................................. 12
  - Define Setup Options ...................................................................................... 13
  - Install Printer Driver from within the ZebraDesigner Environment .......... 13
  - Activate ZebraDesigner for mySAP ............................................................... 14

- **3 • Set Up the ZebraDesigner Software** ....................................................... 15
  - User Interface .................................................................................................... 16
    - Main Window ................................................................................................. 16
    - Using the Keyboard and Mouse Effectively ............................................... 17
    - Interface Reference ...................................................................................... 17
  - System Folder ..................................................................................................... 32
  - Welcome Wizard ............................................................................................... 32
4 • Design Labels ................................................................. 33
Use Label Setup Wizard ..................................................... 35
Use Label Setup Wizard ..................................................... 35
Select a Printer ................................................................. 35
Select the Label Stock ....................................................... 36
Define the Page Size .......................................................... 37
Select the Label Layout ...................................................... 38
Define the Label Dimensions .............................................. 39
Define Custom Scripts ....................................................... 40
Design a Basic Label ......................................................... 41
Overview ................................................................. 41
Create a Basic Label ......................................................... 41
Add Variable Fields .......................................................... 50
Design an RFID Smart Label .............................................. 55
Overview ................................................................. 55
Create RFID Encoding Label ............................................. 56
Encode RFID Tag .............................................................. 56
Support for RFID Tags ...................................................... 58
RFID Tag Locking .............................................................. 60
RFID Tag Settings ............................................................. 60
Change Printer Settings ..................................................... 62
Change Common Printer Settings ....................................... 62
Change Dithering Options .................................................. 63
Use Toolbars ................................................................. 64
Use the Standard Toolbar .................................................... 64
Use the Variable Toolbar .................................................... 65
Use the Toolbox ............................................................... 66
Use the Text Toolbar ........................................................ 67
Use the Design Toolbar ..................................................... 68
Work with Objects ........................................................... 68
Use Text Wizard .............................................................. 71
Use Bar Code Wizard ........................................................ 77
Use Graphics Wizard ....................................................... 80
Bar Code Type Selection ................................................... 81
Select Objects ................................................................. 88
Edit Objects ................................................................. 89
Move Objects ................................................................. 89
Align Objects ................................................................. 89
Resize Objects ............................................................... 90
Rotate Objects ............................................................... 91
Supported Graphics Formats ............................................. 91
Contents

Work with Variable Data ................................................................. 92
Dynamic Data Overview ................................................................. 92
Create Single-Line Variable .......................................................... 92
Create Multi-Line Variable ............................................................ 92
Using Printer Real Time Clock (RTC) .............................................. 93
Use Variable Wizard ................................................................. 94

5 • Export Labels ................................................................. 97
Test Print Labels ........................................................................... 98
Format Generation Wizard .......................................................... 99
Export to Printer ................................................................. 99
Save File on Disk ....................................................................... 101
Save File on Disk and Download Objects to Printer ......................... 104
Use Current Location .................................................................. 105
Send to IP Address ..................................................................... 105
Search Types .............................................................................. 107
Optimize the Printing Speed ......................................................... 114

6 • Technical Support ................................................................. 115
Online Support ............................................................................ 116
Contact Information ..................................................................... 117

Glossary ................................................................. 119
Glossary of Terms ......................................................................... 119

Index ................................................................. 121
1

Introduction

Contents
Welcome ................................................................. 8
Contents of the package ................................................ 8
About this Manual ...................................................... 9
  About this Manual .................................................... 9
  Typographical Conventions .......................................... 9
Welcome

ZebraDesigner software is a family of labeling software products that brings a complete bar code printing solution to desktop users. ZebraDesigner offers an easy-to-use interface and meets any label design and printing requirement for efficient label printing solutions to users in retail, logistics, health care, chemical, automotive, and other industries.


ZebraDesigner for mySAP software is a label designer application. You can use ZebraDesigner for mySAP to design your label templates, export the templates and parse them through the Format Generation Wizard. The resulting label template is used for the off-line label printing with data from different applications.

The latest software is available for download on the Zebra web site at www.zebra.com/software.

Contents of the package

The latest software is available for download on the Zebra web site at www.zebra.com/software

Before starting the installation of ZebraDesigner for mySAP software, check the contents of the package to ensure it is complete. The package includes:

- ZebraDesigner for mySAP CD
- Software Activation key, located on label inside of CD case, or delivered via email if purchased via www.zebra.com

If any of the mentioned items are missing, please contact your software vendor immediately for package replacement.
About this Manual

The ZebraDesigner for mySAP User Guide helps you design and print labels quickly.

The User Guide contains the following sections:

**Introduction**: This chapter will introduce you to ZebraDesigner for mySAP.

**Installation and Activation**: This chapter will show you how to install and activate the labeling software.

**Set up the ZebraDesigner software**: This chapter will show you how to set up and customize software to your preferences and explains all the commands used in the labeling software.

**Design Labels**: This chapter will show you how to create labels. You should refer to this chapter regularly while designing labels, until you have completely familiarized yourself with the commands. By using the information contained in this chapter, you will able to use labeling software quickly and efficiently.

**Export Labels**: This chapter will show you how to print and preview labels.

**Technical Support**: This chapter provides information on how to contact technical support.

**Glossary of Terms**: This chapter describes some of the technical terms used in the document.

**Typographical Conventions**

- Text that appears in **bold** refers to menu names, file names (SETUP.EXE), interface buttons (OK), PC keyboard keys (Alt), and menu flows; menu flows have a > that separates one menu to the next menu (Start > Programs > Zebra Technologies > ZebraDesigner for mySAP).

Text that appears in *italic* refers to confirming actions, identifies graphic captions, identifies text that you need to type, and locations such as Folder.
Installation and Activation

Contents

- System and Software Requirements .......................... 12
- ZebraDesigner for mySAP ..................................... 12
- Install ZebraDesigner for mySAP ......................... 12
  - Install Overview for ZebraDesigner for mySAP ........ 12
- Close All Software Applications ............................ 12
- Run Installation ............................................ 12
- Define Setup Options ...................................... 13
- Install Printer Driver from within the ZebraDesigner Environment ........ 13
- Activate ZebraDesigner for mySAP ....................... 14
System and Software Requirements

ZebraDesigner for mySAP

To run the program, you need at least the following:

- Pentium-based computer with at least 64 MB of RAM.
- One of these 32-bit or 64-bit Windows operating systems: Microsoft® Windows® 2000, XP, Vista, Server 2003 or Server 2008.
- Hard disk with 75 MB of free disk space.
- CD-ROM drive.
- Administrator rights to the local computer during installation.

Install ZebraDesigner for mySAP

Install Overview for ZebraDesigner for mySAP

When you put the ZebraDesigner for mySAP CD in your CD-ROM drive, the installation/demonstration program automatically starts. You can browse the directory of the CD and look at the brochures, technical documentation, sample files, and other documents.

Note • You must be logged on with operating system Administrator rights perform the installation.

Close All Software Applications

To ensure complete installation of ZebraDesigner for mySAP, close all open software applications before you start installing ZebraDesigner for mySAP.

Run Installation

Use the installation wizard to install ZebraDesigner for mySAP on your desktop PC.

To install the software, do the following:

1. Put the ZebraDesigner for mySAP CD in your CD-ROM drive. An installation window automatically opens.
   
   Note • If the installation wizard does not start automatically, go to the main CD directory of your ZebraDesigner for mySAP CD and double-click the file START.EXE.

2. Click Install. A new window opens showing all ZebraDesigner editions

3. Click on the version of ZebraDesigner that you want to install, and follow the prompts.
Define Setup Options

To continue installation, do the following:

1. Click the Next button.

2. Specify the program group you want to use for ZebraDesigner for mySAP.

3. Specify if shortcuts to ZebraDesigner for mySAP should be created on the desktop or in the Quick Launch area.

4. To finish installation, click the Install button.

After installation you will be asked to install a printer driver. It is necessary to install a ZebraDesigner driver. If you do not install a printer driver while installing the software, you will be asked to install one the first time you run the program.

5. Once the installation is complete, the Start menu in Windows shows a new program group for Zebra Technologies that contains shortcuts for all ZebraDesigner for mySAP applications.

Install Printer Driver from within the ZebraDesigner Environment

To install the ZebraDesigner printer driver on your computer, do the following:

1. In ZebraDesigner environment, open the File Menu and click on Install Printer.

2. The printer installation wizard starts.

3. Follow the onscreen instructions.

The driver not only allows you to use all supported Zebra printers with the ZebraDesigner software, but also provides a handy way of sending settings and commands straight to the printer through the driver.
Activate ZebraDesigner for mySAP

Activate ZebraDesigner for mySAP to obtain all features. If you do not complete the activation process, ZebraDesigner for mySAP only runs in DEMO mode.

To activate the software, do the following:

1. Start ZebraDesigner for mySAP.
   The Warning dialog box appears.

2. Click the Activate button.
   Enter the License Number.
3

Set Up the ZebraDesigner Software

Contents
User Interface ................................................................. 16
Main Window .................................................................. 16
Using the Keyboard and Mouse Effectively ......................... 17
Interface Reference ......................................................... 17
System Folder ................................................................ 32
Welcome Wizard ............................................................ 32
User Interface

Main Window

Start the software by clicking on the desktop icon or selecting it from the Start menu: Start > All Programs > Zebra Technologies > ZebraDesigner for mySAP Business Suite 2 > ZebraDesigner for mySAP Business Suite 2

This is the ZebraDesigner for mySAP main window.
Using the Keyboard and Mouse Effectively

- When selecting objects, you can use the Ctrl key to adjust object’s anchoring point by clicking the object placeholders.

- If you have a Wheel Mouse, you can use the wheel to scroll the label up and down. Holding Ctrl when rotating the wheel adjusts zoom factor, and Shift scrolls the label left or right.

- Double-click on printer’s name in status bar to open printer properties dialog box in which you can set various options for currently selected printer.

- You can quickly move objects from one open label to another by dragging the desired object to another window while holding Alt. If you want to copy objects instead, hold both Alt and Ctrl. Note that you must have both label windows visible to do that.

- You can select different objects on a label using the Tab and Shift + Tab keys.

- Pressing the cursor keys while holding the Ctrl key can move the selected object. You can use this to fine-tune the position of the object. Holding Shift while pressing cursor keys will resize the object.

- You can use the right mouse button almost anywhere on the label to access the most common options for that area/object. For example, if you click an object with the right mouse button, a pop-up menu appears that contains options and actions that can be performed on the selected object. Similarly clicking other parts of the label produces pop-up menus with options for that part of the label.

- You can select multiple objects by holding Shift while clicking them.

- Use the element shortcuts in toolbars whenever possible. Each label element that can be connected to some Contents Provider has a shortcut enabled to quickly access existing variables or define new ones. Click the element’s shortcut handle, shown as a small arrow by the side of some toolbox icons.

Interface Reference

Mouse Wheel support

If you have a mouse that has a wheel in place of the middle button, you can use it to speed up zooming and scrolling:

- Turning the wheel scrolls the label up or down.
- Holding Shift and turning the wheel scrolls the label left or right.
- Holding Ctrl and turning the wheel zooms the label in or out.
## Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes selected object</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Alt + Backspace</td>
<td>Undo</td>
</tr>
<tr>
<td>+ (on numeric pad)</td>
<td>Zoom In</td>
</tr>
<tr>
<td>- (on numeric pad)</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Alt + Shift + Backspace</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Rotate 90°</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Align</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>New</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Print preview</td>
</tr>
<tr>
<td>Ctrl + move the object with mouse</td>
<td>Parallel moving of the object by main axes only</td>
</tr>
<tr>
<td>Alt + move the object with mouse</td>
<td>Objects snap to grid even if it is off</td>
</tr>
<tr>
<td>Ctrl + move the object with cursor keys</td>
<td>Fine tuning the position of the object</td>
</tr>
<tr>
<td>Shift + cursor keys</td>
<td>Fine tuning the dimensions of the object, resize width and height in very small steps</td>
</tr>
<tr>
<td>Right-clicking the object</td>
<td>Opens pop-up menu with shortcuts to commands. The content of the pop-up menu depends on where you clicked your mouse button and what was selected at that time</td>
</tr>
<tr>
<td>Enter F2 or double-click</td>
<td>Opens properties dialog box of the selected element</td>
</tr>
<tr>
<td>Shift + resizing of the variable text object</td>
<td>Allows you to resize the frame text container</td>
</tr>
</tbody>
</table>
File Menu

New Label

To create a new label and clear the application work area, select New Label command from File menu. Clicking the button has the same effect.

The software supports opening multiple documents and they are named with the increasing numbers: Document1, Document2... unless you save them to different filename.

The Label Setup Wizard dialog box will appear on your screen. Label Setup Wizard offers defining dimensions of the label and changing printer setup.

Open

This command opens an existing label. You can also click the button in the standard toolbar.

The default label folder is My Labels from My Documents. This folder also includes shortcuts to folder with sample labels. When you need to open a label file, which has been saved on a different folder or drive, you can use Windows browse function to access it.

When searching the existing label, the Preview option can help you. Using it, the label design of an existing saved label can be seen on the left-bottom frame, accompanied with the label details: its title and description.

Once you have found the appropriate label, you can open it by double clicking its name, or by clicking the Open button.

Close

This command closes the active document. When you have made changes in the document and have not saved them, the program will prompt you to save the label.

If the document has not been named yet, the software will also prompt you for the name (Save command will be executed).

Save

This command saves the active label in the current label file. If no file name has been defined yet, you will enter the Save dialog box.

The Save command can also be accessed directly by click the button.

Save As

Select this command when you want to name a new label or when you want to copy an existing label under the new name or to another folder or drive.

The default folder to save the labels is My Label in My Documents. When you need to save the label to a different folder or drive, you can use Windows browse function to define the target folder.
Export to Printer

Export the label to the printer so it is available for the stand-alone printing. During the exporting process Format Generation Wizard dialog box will be shown allowing you to define the properties of exported label.

Label Setup

Should you want to change the label parameters, such as dimensions or print orientation, use the Label setup command from the File menu or double click the label. The Label Setup Wizard dialog is shown.

Install Printer

Select this command when you want to run the printer installation wizard. After completing the wizard, the printer becomes available, and Zebra Designer does not need to be restarted.

Remove Printer

Select this command when you want to remove one of your installed printers.

The printers that are currently used by the application are shown as disabled and cannot be removed. The removal of the printer does not require a restart of the application.

Printer Settings

Specific printer settings are set here. The shortcut to this dialog is to double click the printer name in a status bar in the bottom of the working window.

Note that all printer settings are saved with the label and are restored every time the label is opened. Each label will store its own custom printer settings. In case you want to print the label with a different printer, this other printer will have to be setup again to suit your needs. When changing the printer used on the label, every custom setting is lost and have to be re-configured.

When you change the printer on the label or when you create a new label the default printer settings are used. These default settings can be set for each printer in Control Panel.

Test Print

The Test print command will print the current contents to the printer as defined on the label. All variable fields on the label are automatically filled with the default values.

The label will be printed in one copy. The purpose of this command is to quickly print the label, so you can verify if the label objects are positioned on the right place and aligned to each other correctly.
Recently Used Files

At the bottom of the pull down menu, the file names of the four most recently edited labels are shown, available for quick selection.

Selecting the file here is the same as choosing the Open command from the File menu and selecting the file there.

Exit

Use this command to leave the labeling application. When using the keyboard, the shortcut to this command can be invoked by pressing the Alt and F4 keys simultaneously. If the opened labels haven’t been saved yet, you will be prompted to do so.

Edit Menu

Undo

The Undo command cancels up to 10 of the most recently carried out commands or actions. If you do not like the results of a command, or accidentally delete some elements, choose the Undo command as the next action to restore the previous mistake.

The Undo command can also be activated by clicking the button on the toolbar, or pressing the Alt and Backspace key simultaneously.

Redo

The Redo command is used when you need to restore the last Undo action. It also has the capability to store (and restore) up to 10 previously made steps.

The Redo command can be activated by clicking the button on the toolbar, or pressing Shift, Alt, and Backspace keys simultaneously.

Cut

This command is used when you want to remove selected element(s) from the label. Note that the first element is selected by clicking it. When you want to select additional elements, you must press and hold down, the Shift key while clicking each additional element.

The cut elements are stored in the internal clipboard and can be re-inserted on the label with the Paste command. The combination of Cut and Paste commands can be used to speed-up label editing and designing.

The Cut command can be also activated by clicking the button on the toolbar, or by pressing the Shift and Del keys or Ctrl and X keys simultaneously.
Copy

This command copies the selected elements to the Windows clipboard.

Clicking the button or pressing Ctrl and Ins keys or Ctrl and C keys simultaneously can also activate the Copy command.

Paste

The Paste command is used to paste the contents of the clipboard to a label. This command can be used to paste the same information more than once.

It is very useful when you need to have multiple copies of the same element on the label.

Once the element has been designed, it can be copied to the clipboard and pasted on to the label, in different places and multiple times.

You can also design objects in other Windows applications, copy them to the clipboard, and place them on the label with the Paste command.

Clicking the button or pressing the Shift and Ins keys or Ctrl and V keys simultaneously can also activate the Paste command.

Paste Link

Using the Paste link command establishes a link between labeling application and the source application for the contents of the clipboard.

The link information is saved in the source file; only the location of the information in the source file is saved. The link data shows in the graphic form.

Double clicking a Paste-link object will place you into the original source Windows application for that object. The object is then edited in the application.

Delete

The command is used to delete selected elements. Deleted elements are not stored in the clipboard. To restore deleted elements, the Undo command must be used before any further actions. Delete command can also be activated using the Del button.

Select

This command allows you to select different objects on the label.

You can select all objects on the label, or selectively mark only objects from the same group (i.e. all text objects, all bar code objects, all picture objects, etc).
Links

On the screen this command shows a list of all links between the active label and other applications in your working environment. When you insert an object on the label with the Paste Link command, you will see this link in the list.

The links can be interrupted. This means that the changes made in the source document will not be made on the label.

View Menu

Normal View

Selects normal label view.

In this view type, variables are shown on screen as a series of question marks (?). The number of question marks corresponds to the variable length. Use this view to precisely position the elements on the label as you know their maximal possible length.

Data View

Selects the data label view.

The variable elements are shown as they will appear when printed. For example, counters will show numbers.

Zoom In

Zoom in command shows a smaller section of the label. The + key of the numeric keypad can also be used. Each time Zoom in is selected, the displayed picture becomes 10% bigger.

Zoom Out

Zoom out command shows a wider view of the label. The - key of the numeric keypad can also be used. Each time Zoom out is selected, the displayed picture becomes 10% smaller.
Zoom

When using the **Zoom** command, you can define the optional zoom factor you need. You can choose any zoom factor from 5 to 3000.

![Zoom dialog box](image)

**Figure 1 • Zoom dialog box**

In the **Zoom** dialog box you can select the different ways of zoom.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100%</td>
<td>The size of the document on screen will be the same as the size of the document on the label.</td>
</tr>
<tr>
<td>To page</td>
<td>You will see the entire page on the screen.</td>
</tr>
<tr>
<td>To label</td>
<td>You will see the entire label on the screen.</td>
</tr>
<tr>
<td>To objects</td>
<td>You will see all the objects on the screen.</td>
</tr>
</tbody>
</table>

**Snap to Grid**

Selecting this option enables the positioning of the objects to be based on the grid settings. When you move the objects, they are placed on a grid position. De-selecting this option allows elements to be freely moved on the label.

Upper left corner of the object is used for starting point of the grid.

Grid size cannot be modified.

**Display Grid**

Selecting this option makes the grid visible on the label. De-selecting the option hides the grid.
Toolbars

**Standard Toolbar**

Buttons in the standard toolbar provide shortcuts to frequently used commands for working with the software.

**Design Toolbar**

The design toolbar provides you with the shortcuts to the frequently used design actions on the label.

By default, the design toolbar is docked on the right side of the design window.

You can use the design toolbar to:

- Change the color of label objects.
- Align the objects relatively to each other or to the label.
- Rotate the objects.
- Change the order of the objects.

**Text Toolbar**

Shortcuts in the text toolbar enable you to format text objects with a single mouse click. You can change font selection and style.

**Variable Toolbar**

Shortcuts in the variable toolbar enable you to work with variables on the label easier. You can add new variables, edit and delete existing ones and also work with functions.

**Toolbox**

**Select**

Use this tool to enable the select tool.

**Text**

Use this tool to define the text object.

Click on the small arrow button for additional options.
Bar code
Use this tool to define the bar code object.
Click on the small arrow button for additional options.

Picture
Use this tool to define the picture object.

Rectangle
Use this tool to define the rectangle object.

Line
Use this tool to define the line object.

Ellipse
Use this tool to define the ellipse or circle object.

Inverse
Use this tool to define the inverse object.

RFID Tag
Use this tool to program the RFID tag embedded in the label.

Object Properties

Printer Objects
Select this option to distinguish printer internal objects from other (graphical) objects on the label. The printer internal objects are framed with the green dotted rectangle.

Printer Counters
Select this option to distinguish printer counters from other (graphical) objects on the label. The printer counters are framed with the green dotted rectangle.

Object Menu

Select
After you select the Select command in the Object menu or click the button in the Toolbox, the arrow cursor appears.

Use this command to select objects on the label.
Text

After you select the Text command in the Object menu or click the button in the Toolbox, the cursor with the bar text appears.

Use this command to place text objects on the label.

Bar Code

After you select the Bar Code command in the Object menu or click the button in the Toolbox, the cursor with the bar code symbol appears.

Move the mouse cursor to the desired position of the label and click to enter the Bar Code Wizard dialog box.

Picture

After you select the Picture command in the Object menu or click the button in the Toolbox, the cursor with the picture symbol appears.

Select this command to place a picture on the label.

Rectangle

After selecting the Rectangle command in the Object menu or clicking the button in the Toolbox, the cursor with the rectangle symbol appears.

**Thickness:** Defines the width of the object borders.

**Note •** The valid values for thickness depend greatly on the printer being used on the label. Not all values are acceptable for all printers.

**Rounded Rectangle:** With this option you can define rounded corners of the rectangle. You can select thickness and radius for the object.

Line

After you select the Line command in the Object menu or click the button in the Toolbox, the cursor with the line symbol appears.

Use this command to draw lines on the label.

Ellipse

After you select the Ellipse command in the Object menu or click the button in the Toolbox, the cursor with the ellipse symbol appears.
**Thickness:** Defines the width of the object borders.

**Note:** The valid values for thickness depend greatly on the printer being used on the label. Not all values are acceptable for all printers.

**Inverse**

After you select the Inverse command in the Object menu or click the button in the Toolbox, the cursor with the inverse symbol appears.

Adds an inverted box to the label. The inverted box turns inverses the color of all underlying objects.

**Note:** The command Inverse is not available for all printers. If the printer does not support Inverse functionally internally, the command cannot be selected.

**RFID Tag**

The button is used to enable programming of RFID tags embedded into the labels.
Tools Menu

Edit Memory Card

Select this command to start the application ZebraDesigner Font and Graphics Downloader. Use the Downloader to store frequently used TrueType fonts and pictures into the printer memory or memory cards for faster printing. Because the data is already pre-loaded in the printer you need to send less data to the printer during printing, resulting in faster printed labels.

Note • For more information please refer to the user guide or help file for the ZebraDesigner Font and Graphics Downloader.

User Interface

Toolbox

Bar codes

Display toolbar with bar codes for easier access to the available bar code types.

Captions

Display captions next to the icons in the Toolbox.

Large Icons

Use large icons in the toolbars.

Small Icons

Use small icons in the toolbars.

Menus Show Recently Used Commands First

Enable this option to show only recently used commands in the menus.
All other commands are hidden to minimize the length of the menus.

Printer Tools

Printer Tools allow you to send specific commands directly to the printer. These commands are simply pre-programmed strings of commands that you would be able to enter in the Direct Communication interface. The Printer Tools interface provides a user-friendly tool which allows the sending common commands to the printer, without the need for the printer to provide a reply to the user. The commands are divided into the following two categories:

• Print – includes commands which trigger printing

• Action – includes commands which alter a setting in the printer and do not trigger printing
Language

![Language dialog box]

Select the working language for the software. The change will be applied after you have restarted the application.

You can change the language used in the application with this option. For changes to take effect application must be restarted.

Store Pictures into Label

This option allows you to store the images used in the label into the label file. This enables you to transfer the label to a different computer by simply transferring the label file. If this option is not selected, images are lost when the label file is transferred to a different computer.

Windows Menu

Cascade

Use this command to cascade all open windows.

**Note** • Make sure all the windows you want to display are open. Minimized windows cannot be displayed.

Tile

Use this command to tile all open windows in working space.

**Note** • Make sure all the windows you want to display are open. Minimized windows cannot be displayed.
**Arrange Icons**

Use this command to arrange icons (minimized windows) in working space - to the bottom of it. This has effect only if icons are not already arranged.

**Close All**

This command closes all open windows (documents) with prompting for all unsaved documents. Use it to quickly close all windows with one command (otherwise you have to use Close command in File menu for each window).

**Window List**

When one or more windows (documents) are open, they are all listed. You can quickly switch between windows by selecting an appropriate one. If more than nine windows are opened, more are accessible by choosing option *More windows*…

**Help Menu**

**Contents**

This command opens the contents file for this help.

**About**

This command displays the application version information and name of the user that has installed and registered the application.
System Folder

The labeling application uses its system folder for storing files needed to run the program. The location of the folder varies depending on the Windows operating system used.

The location is `C:\Documents and Settings\All Users\Application Data\Zebra Technologies\ZebraDesigner for mySAP Business Suite 2`.

It is important to own **the write/modify access** to this folder on your computer system.

In these files, user data and user rights are stored, as well as custom settings, variable trace logs, label usage logs, variable definition files `*.LVR`, stock file database and bar code standards.

Welcome Wizard

When you start the labeling software, a Welcome Wizard will appear. It provides a quick access to most-used commands when starting working on a label layout.

<table>
<thead>
<tr>
<th>Create a new label</th>
<th>A blank label will appear and Label Setup Wizard will start. You can then design a new label from a scratch.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open recently used label</td>
<td>A list of recently used labels will appear to provide a quick access to commonly used labels.</td>
</tr>
<tr>
<td>Open some other existing label</td>
<td>A common Windows dialog box opens to let you browse for the appropriate label file.</td>
</tr>
</tbody>
</table>
4

Design Labels

Contents

Use Label Setup Wizard .................................................. 35
Use Label Setup Wizard .................................................. 35
Select a Printer ......................................................... 35
Select the Label Stock .................................................. 36
Define the Page Size .................................................. 37
Select the Label Layout .................................................. 38
Define the Label Dimensions ........................................... 39
Define Custom Scripts .................................................. 40
Design a Basic Label .................................................... 41
Overview ................................................................. 41
Create a Basic Label .................................................... 41
Add Variable Fields .................................................... 50
Overview ................................................................. 55
Create RFID Encoding Label ........................................... 56
Encode RFID Tag ....................................................... 56
Support for RFID Tags ................................................ 58
RFID Tag Locking ....................................................... 60
RFID Tag Settings ....................................................... 60
Change Printer Settings ............................................... 62
Change Common Printer Settings .................................... 62
Change Dithering Options ............................................. 63
Use Toolbars ........................................................... 64
Use the Standard Toolbar ............................................. 64
Use the Variable Toolbar ............................................. 65
Use the Toolbox ......................................................... 66
Use the Text Toolbar ................................................... 67
Contents (Continued)

Use the Design Toolbar ................................................................. 68
Work with Objects ........................................................................ 68
Use Text Wizard ........................................................................... 71
Use Bar Code Wizard ................................................................. 77
Use Graphics Wizard ................................................................. 80
Bar Code Type Selection .............................................................. 81
Select Objects ............................................................................. 88
Edit Objects ................................................................................ 89
Move Objects .............................................................................. 89
Align Objects ............................................................................... 89
Resize Objects ............................................................................ 90
Rotate Objects ............................................................................ 91
Supported Graphics Formats ....................................................... 91
Work with Variable Data .............................................................. 92
Dynamic Data Overview ............................................................. 92
Create Single-Line Variable ....................................................... 92
Create Multi-Line Variable .......................................................... 92
Using Printer Real Time Clock (RTC) ........................................... 93
Use Variable Wizard ................................................................. 94
Use Label Setup Wizard

With the Label Setup Wizard you can define the dimensions of the label and change printer setup. It consists of a few simple steps.

Select a Printer

Choose the printer from the list of installed printers. The label will be optimized for this printer.

```
ZDesigner 105SL 203dpi
```

You can change the printer-specific settings by clicking the 'Properties' button.

Figure 3 • Label Setup Wizard - Selecting printer

If you want to set the printer parameters, select the desired printer, and click the Properties button. The printer properties dialog box appears, allowing you to set the printer parameters such as print speed, print darkness, and print direction.

Note • This is a standard Windows printer properties dialog box and its options may differ from printer to printer because it is based on the printer driver.

To continue, click Next.
Select the Label Stock

If you use one of the standard predefined label formats, you can specify it here.

**Stock Type:** Select the type of stock.

**Stock name:** Select the stock from the list.

**Stock information:** The information about label dimensions, printer settings, and background images as defined by the selected stock.

**Label linked to stock:** If you enable this option, you cannot change the dimensions of the label, because the stocks locks the dimensions.

**Note** • Using pre-defined stocks simplifies the process of label creation because you do not have to define the label dimensions manually.

To continue, click the Next button.
Define the Page Size

Figure 5 • Label Setup Wizard - Choosing label dimensions

Select the page size for your labels.

**Automatically set from label dimensions:** ZebraDesigner printer drivers will automatically size the label dimensions.

**Select page size:** You can also manually define the page size.

To continue, click Next.
Select the Label Layout

![Label Setup Wizard](image)

**Orientation:** Select the label orientation. Look at the screen and printer layouts to see how the label will be printed from the printer.

**Print directions:** Click the Rotated option to rotate the label 180 degrees, when printed.

To continue, click the Next button.

---

**Figure 6 • Selecting label layout**

**Orientation:** Select the label orientation. Look at the screen and printer layouts to see how the label will be printed from the printer.

**Print directions:** Click the Rotated option to rotate the label 180 degrees, when printed.

To continue, click the Next button.
Define the Label Dimensions

Enter the label dimensions in this dialog box.

**Note** • If you selected the label stock in the previous step, the values for dimensions are entered automatically.

![Label Setup Wizard - Defining the label format](image)

**Figure 7 • Label Setup Wizard - Defining the label format**

- **Width, height**: Define the label dimensions.
- **Margins**: Define the label margins.
- **Rows, columns**: Define the number of labels in horizontal and vertical directions. Usually you will design a label with only one row of labels and let the sensor in the printer determine the start position of the next label.
- **Gaps**: Define the gap between the labels.
  - **Note** • Define gaps only if you changed the rows and columns options. If you have rolls of labels, the gaps between the labels are auto-identified by the gap sensor in the printer.
- **Unit of measure**: Change the unit of measure you want to use.

When you are satisfied with the label dimensions, click the **Finish** button to close the Label Setup Wizard.
Define Custom Scripts

Use this dialog box to define the custom printer commands and include them in the printer stream data. Normally, ZebraDesigner for mySAP will process your label file and export the appropriate printer commands to the printer. Here you can define additional commands that you want to send to the printer, as the first commands in the stream file, or the last commands in the stream file.

Use Header Script: Click on this option to send the custom script to the printer in front of the label data. Enter the script in the provided space.

Use Footer Script: Click on this option to send the custom script to the printer at the end of the label data. Enter the script in the provided space.

Note • This option is for advanced users. Make sure to enter the proper commands in your scripts. The label might not print correctly, if you do not format your script correctly. Use Zebra Programming Language (ZPL) to enter the script.
Design a Basic Label

Overview

In this section you will learn how to design a simple label file with fixed and variable objects. The variable objects get values from several sources. You will learn how to:

• Place objects on the label.
• Link objects to the variables.
• Preview the label on the screen.

The label you create will look like this:

![Figure 8 • Basic label](image)

Create a Basic Label

Create a New Label

To create a basic label, do the following:

1. Open ZebraDesigner for mySAP.
2. From the File menu, select New or click the button in the Standard Toolbar.

Each time you create a new label, a Label Setup Wizard will start to help you set up the label and connect to the printer.

Note • You can leave the Wizard at any time and accept the default settings for the label by clicking the Finish button.
Select a Printer

1. Select the printer you want to use for label printing.

   **Note** • If you don’t find your printer on the list, see Install Printer Driver from within the ZebraDesigner Environment for installation instructions.

![Label Setup Wizard](image)

**Select Printer**

Select the printer you want to use with this label.

Choose the printer from the list of installed printers. The label will be optimized for this printer.

![Select Printer Interface](image)

You can change the printer-specific settings by clicking the 'Properties' button.

![Properties Button](image)

2. Click the Next button.
Define Label and Page Dimensions

1. If you want to use the label stock, select your choices in the Select Stock window.
2. Click the Next button. A new window opens to define the label dimensions manually.
3. Leave the Page Size option at User defined default and check Automatic Sizing.
4. Click the Next button. A new window opens.
5. Select label orientation and print direction.

![Label Setup Wizard](image)

6. Click the Next button. A new window opens.
7. Enter 3 for label width and 2 for label height.
   - **Note**: Dialog box differs for thermal and office printers.
Figure 11 • Defining label dimensions

Note • To change the unit of measure from centimeters to inches or other supported units, click on the button with unit of measure below the label preview in the dialog box.

8. Click the Finish button. New empty label opens.

Enter Fixed Text

1. Click the Text button in the Toolbox. The text cursor appears on the screen.

Figure 12 • Cursor for text object

2. Move the cursor to the location on the label where you want to place the text object and click the mouse button. The Text Wizard dialog box with object properties opens.

3. Type SAMPLE and click the Finish button.
4. Click on the text object to select the object.

5. Using the Text Toolbar, change the font for the text object. Choose Arial font, 28 point size, and bold style.
Using format options in the text toolbox:

6. To change the position and size of the text object, select the text object and drag the object with your mouse to the position.

The screen should show the following:

![SAMPLE](image)

**Figure 14 • The text object is placed on the label**

**Object Positioning Guidelines**

Guidelines are available to assist you in positioning objects on the label. The functionality of guidelines is similar to grid, but they allow you much more freedom regarding positioning, moving, and combining positioning delimiters.

Although the guidelines may be visible while designing the label, they will not be printed on the final product, regardless of whether the Display Guidelines setting is turned on or off.

**Create Guidelines**

Create vertical and horizontal guidelines:

- Click anywhere in the ruler area and drag the line out of it (the top ruler contains horizontal, and the side ruler contains vertical guidelines).
- Finally, you can open the View menu and access the commands there.

**Using Guidelines**

The guidelines may be moved at any time with the drag of a mouse. If they are dragged back to the ruler area, they are deleted. It is possible to toggle between displaying and hiding the guidelines, either by using the menu or right clicking them.

The guidelines can be hidden with the Ctrl+H shortcut key combination, and when they are hidden, the Snap to Guideline functionality is also disabled. The menu also includes a Remove all Guidelines command, which removes all the guidelines on the label.

Holding down the SHIFT key while dragging objects allows you to temporarily turn on the Snap to Guidelines function.
Guideline Properties

Double-click a guideline or right click a guideline and choose **Edit Guideline Properties** to open the Guideline Properties dialog window. The dialog allows you to enter the numeric positioning value, choose the horizontal or vertical guideline type, or remove the individual guideline.

**Note** • This functionality is only available in ZebraDesigner Pro and for mySAP.

Insert Bar Codes

Now you will add a non-changeable Code128 bar code on the label.

1. To insert the bar code, click the ![Bar Code](button) button in the **Toolbox**.

2. Move the cursor to the desired position on the label and click the mouse button. The Barcode Wizard dialog box with object properties will open.

3. Enter the value 1234567890 for the bar code contents.

4. Click the **Define** button. **Edit Bar Code** dialog box opens.

5. Make sure you select bar code Code128 and click the **OK** button.

![Edit Bar Code dialog box](image)

**Figure 15** • Selecting bar code type

6. To return to the label, click the **Finish** button.

7. Change the position of the bar code by selecting the bar code and dragging it to the desired position.
8. Change the object size by dragging the object handles. The handles are small rectangles surrounding the object when it is selected.

The label should now show the following:

![Sample label with text and bar code objects](image)

**Figure 16 • Label with text and bar code objects**

**Insert Pictures**

The ZebraDesigner for mySAP works with BMP, PCX, GIF, WMF, JPEG and many other popular graphic formats.

1. To insert the picture, click on the **Picture** button in the Toolbox.

2. Move the cursor to the desired position on the label and click the mouse button.

3. The *Open* dialog box will open allowing you to browse for a picture on your hard drive. Go to the folder *Sample Graphics* and select the picture *LEISURE.WMF*.

4. Click the *Open* button.

The screen should show the following:

![Sample label with text, bar code, and picture objects](image)

**Figure 17 • Label with text, bar code, and picture objects**
Design Labels

Design a Basic Label

**Save a Label**

**Note** • Always save your label during the design process.

**To save a label, do the following:**

1. Click the **Save** button.

2. Type in the name of the label. For example, type *label* for the name of the label. The name of the label appears in the program caption.

**Use Alignment Tools**

You have placed the objects on the label. Now you want to make sure they are aligned on the horizontal center of the label. You can align objects on the label by using the **Align Toolbar** on the right side of the working window.

**To align objects on the label, do the following:**

1. In the **Toolbox**, choose a select arrow and draw a frame around all objects to select all objects.

   **Note** • The first object you select determines the alignment orientation for all selected objects.

2. To arrange the objects, click the **Center Align** button in the Design toolbar. The selected objects will be rearranged and positioned, centered to first object that was selected.

   **Note** • **Align Toolbar** has other alignment commands available in the **Align Toolbar**. You can also align the objects to the label grid. The option Snap to Grid is available in the View menu.

![Sample Label](image)
Use Drawing Tools

Now you will insert a line to separate a text object from other objects and a rectangle around the picture object.

1. From the Toolbox, select the button and move the cursor to the required starting point of the line.

2. While drawing the line, press and hold down the mouse button. Move the mouse to the end position of the line and release the button. The Line object is placed on the label.

3. In the Toolbox, click the button and point the mouse to the upper left corner of the picture.

4. While you stretch the rectangle to the lower right corner of the picture, click and hold the mouse button.

5. To change the thickness of the vertical and horizontal line, double-click on the rectangle object to open its properties. Select the thickness you want and click the Finish button.

6. To edit the drawing object, double-click on the rectangle to open the dialog box with its properties.

The label should show the following:

![Label with fixed objects](image)

Add Variable Fields

**Overview**

You may want to print a label on which the data changes for each label. ZebraDesigner for mySAP offers different variable fields (date/time fields, link to the variables) that you can use with text, picture, and bar code objects.

For this example, a new label was created. The steps in the following topics explain how to create a label that contains a variable field, a counter, and date/time fields.
Create Variable Fields linked to Variables

The object on the label that is linked to the variable can have different value for each printed label.

To create a text object linked to the variable, do the following:

1. Click the button in the Toolbox.
2. Click the label where you want to place the text object. A Text Wizard starts.
3. Select Variable text for the Contents.
4. Click the Next button.
5. Select Variable Field.
6. Click the Next button.
7. Select one of the existing variables in the list. If no variable is available in the list, you will have to create some. Refer to the topic Variable Wizard.
8. Click the Finish button. The text object is placed on the label and linked to the selected variable.

Note • This example shows how to create a text field linked to the variable. You can use the same approach to create and link variable to the Bar Code object.

Create Date and Time Variable Fields

Content of the variable field can be filled automatically with the date or time stamp from the printer’s real time clock (for supported printer models).

To place a date field on the label, do the following:

1. Click the small arrow next to the button in the Toolbox.
2. From the list, select New Date Field.
3. Click on the label where you want to place the object. A dialog box with date properties opens.
4. Leave everything as default, and the date will be used on the label using the selected format.

5. Click **Finish**.

To place a time field on the label:

6. To display a list of available variable types, click the small arrow next to the **Text** button in the **Toolbox**.

7. From the list, select **New Time Field**.

8. Click on the label where the object should be placed.

9. Leave everything as default and the time will be used on the label using the format as defined in your Windows operating system.

10. Click **Finish**.

   The new variable is linked to the text object on the label.

The date and time fields are updated when you preview or print the label. In this example, the values come from your computer’s system clock.

**Use Prefix or Suffix Options**

You can add a prefix and suffix to each variable field on the label. Both are added to the value when you preview and print the label.

**To add the suffix to the variable field on the label, do the following:**

1. Click the arrow in the **Text** button in the **Toolbox**.

2. From the list, select **New Time Field**.

3. Click on the label where you want to place the object. A dialog box with time properties will open.

4. Click **Next** to advance to the next step.

5. Enter **Time:** for the **Prefix** option.
6. Click **Finish**.

   The text object is placed on the label and linked to the new variable. When you print the label, the prefix *Time:* will be appended to the time value on the left side.
Resize Variable Fields (Shift-dragging)

The size of the variable fields on the label is determined by their sample data. The sample data is defined during the variable creation process. The text object on the label is always as wide as the width of the sample data formatted in the current Zebra font.

If the values for the variable will always occupy the same length or less as the sample data, the label is printed correctly. But if the provided data will be longer than the sample data, the text object can overlap the object to its right.

To avoid overlapping, you can resize the variable fields on the label.

To resize the variable fields on the label, do the following:

1. Select the variable text object on the label.
2. Press and hold the Shift key.
3. Resize the object to the right.

   The new object frame defines the maximum extend to which the variable value can occupy the space on the label.

   Note • You can resize the object only to the right side.

Resize Variable Field linked to Single-Line Variable

If you resize the object linked to the single-line variable, the contents for the object will be visible to the end of the object frame only.

For example, you have entered "SAMPLE" for the sample data. You have then resized the object for one additional character to the right side. When you will print the label with value "DESIGNER", not the whole text is printed. The text that does not fit into the designed frame, will be cut.

Resize Variable Field linked to Multi-Line Variable

If you resize the object linked to the multi-line variable, the contents of the object will automatically reformat into the multi-lines. The printer will reformat the text to optimally fill into the designed frame.
Design an RFID Smart Label

Overview

The concept of RFID (Radio Frequency IDentification) can be simplified to that of an electronic bar code. First emerging in the 1980’s, RFID was primarily used to track objects in industrial environments where bar codes were unable to sustain the harsh surroundings. Today, RFID is being used to track proprietary assets, automate access control and has many more additional fields of usage.

Some thermal printers have the ability to program a RFID tag at the same time as they are printing the label. Two different technologies and their encoding methods are joined on the same label. Of course a label must have embedded a RFID tag. The tag is paper thin, flexible and small in size which allows it to be placed inconspicuously under the label. It consists of an etched antenna and a tiny chip that can store ID number or your custom data in larger quantities. This contrasts with a bar code label, which does not store any enhanced information, but merely some code number.

RFID refers to technologies that use radio waves to automatically identify individual or groups of items. The labeling software and ZebraDesigner driver support programming and printing of RFID tags embedded in a label.

Note • You can use RFID functionality in the labeling software only if you have installed a Zebra Driver with RFID support. Make sure you install the Zebra Driver for your RFID printer before you design and print an RFID smart label. RFID functionality is only available with ZebraDesigner Pro.
Create RFID Encoding Label

1. In the **Standard toolbar**, click the button. The Label Setup Wizard will start.

2. Select the printer that supports RFID smart label printing.

3. Click the **Finish** button.
   You will see that RFID tag command is enabled in the Toolbox on the left side of the label design environment.

4. Click **RFID Tag** in the Toolbox and define the data you want to encode into the RFID tag.

**Encode RFID Tag**

The RFID tags that are embedded into the label are usually one of these types:

- ISO tags, which encode blocks of data
- UHF and HF tags, which can encode one string of data.
1. In the Toolbox to begin encoding the data, click on \( \text{RFID Tag} \). The \( \text{RFID tag} \) dialog box opens.

![Figure 24 • Encoding contents for RFID tag](image)

2. From the list box on the top of the dialog box, select the type of the RFID tag you want to use.

3. Select the Write data to RFID tag option.

   **Note** • If you don’t select this option, the definition of tag content is saved but not sent to the printer.

4. In the section Data Block, from the Data Type drop-down, select HEX or ASCII.

5. Enable the Fixed or Variable radio button based on your desired variable.

6. Click the OK button.

   A schematic view of the RFID Tag antenna will open in the label background identifying the definition of the RFID data on the label.
You can continue designing the smart label with non-RFID data as described in the previous sections.

Note • When you print the label, the RFID data will be sent to the printer. The printer prints the RFID smart label and programs the RFID tag embedded into the label at the same.

Note • ZebraDesigner for mySAP can also work with Unique RFID tag numbers. Each RFID tag has embedded a unique serial number. All RFID Zebra printers can read the Unique RFID tag number from the RFID tag and use it on the label as data contents of some label object.

Support for RFID Tags

With the labeling software you can program RFID tags of different manufacturers. It is important to use a ZebraDesigner printer driver. You cannot program RFID tags, if you do not use the ZebraDesigner Driver.

ZebraDesigner Driver will let the labeling software know which types of RFID tags the printer supports.

Not all tag types are always available. The kind of RFID tags that will be available depends on the selected printer model. There are generally two types of tags:

• ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be encoded in multiple blocks.

• UHF tags (EPC): The data is encoded in one block of data.

You can input content for RFID tags using different methods, depending on the tag type (UHF or ISO).

For UHF tags

Data type: Data type of the selected tag can be specified here.
Data source: Incoming data that is encoded in the tag can be a fixed value or acquired from some variable, defined in the label.

Data size: The currently used data is previewed here. You can see the amount of space still available in the tag. The occupancy of the tag is seen graphically with growing bar and numerically with the digit, explaining the number of already used bytes.

Block locked: If you set the block as locked, the data will be permanently encoded into the tag. You will not be able to erase this block to re-program it with some other value. Use this option with caution!

For ISO tags

The blocks that are dimmed and inaccessible are reserved blocks that cannot be used.

Block Number: The successive number of block in the tag.

Data source: Select where the data block will receive the data from. It can be Fixed, where you will manually type in the data or can be Variable, where the value is acquired from some variable defined in the label.

Data: Type in the tag value manually, if the selected data type is Fixed. Select the variable defined in the label, if the selected data type is Variable. If your variable length is greater than the block size, the next block will automatically be reserved for the data.

Size: The currently used data is previewed here. You can see the amount of space still available in the tag. The occupancy of the tag is seen graphically with growing bar and numerically with the digit, explaining the number of already used bytes.

Data type: The data can be encoded as ASCII string or as HEX encoded string.

Locked: If you set the block as locked, the data will be permanently encoded into the tag. You will not be able to erase this block to re-program it with some other value. Use this option with caution!
RFID Tag Locking

Tag locking is not available for all tag types, printers, and drivers. If the Locking Settings... button is not displayed in the RFID tag dialog window, you may be using an unsupported RFID tag type, printer, or driver. The locking settings are available for some GEN2 tag types. For more information, see your printer and driver documentation.

RFID tag locking enables the user to lock the RFID tag, so that no changes can be made to it without unlocking the tag first. If the tag is permanently locked, it is not possible to unlock it, and the RFID tag can never be changed.

Preserve original locking setting: The original locking setting cannot be retrieved, but the default option assumes that the tag setting should remain unchanged.

Lock: The RFID tag is locked and further changes to it are prevented.

Unlock: The RFID tag is unlocked, so that it can be changed.

Relock: The RFID tag is unlocked, the changes are applied, and the tag is locked immediately after.

Permanent lock/unlock: Checking this box will apply your selection above permanently and prevent later changes to it. This setting cannot be undone.

RFID Tag Settings

Tag Information: This section provides the information about the selected tag type. You can see the structure of the selected RFID tag. The outlook of the information depends on the selected type of the tag. For RFID Gen2 you will see table-like structure with the information about the available data fields, number and size of the block, read or write support.

For other RFID tags, you can review the following structure:

Number of blocks: The number of blocks that are available in the RFID tag.

Reserved blocks: The number of blocks that cannot be accessed and used.

Block size: The size of each block (in bytes).

Unique RF Tag: This property is set to Yes, if you have the printer and/or the tag type that can provide you with the Unique Tag ID. Each tag has a unique ID encoded already in the production line. If your printer can read this information from the tag, you can use it with the label objects using RFID Tag Contents contents provider.

For example: The printer scans Unique Tag ID, remembers it and prints it on the label encoded in a bar code element. The value of Unique Tag is never returned to the labeling software. It is handled internally by the printer.

RFID Tag Data Read: This property is set to Yes, if you have the printer and/or the tag type that allows the extraction of the encoded data. You can extract all or part of the data encoded in the RFID tag and use it with the label objects.

Tag Settings: This section provides more control for RFID programming.
**Antenna offset:** To achieve better programming accuracy use this option to define the offset for the antenna in the printer. The Offset is the distance from the antenna to the embedded tag on the label. This option will help you program the tags more accurately.

**Maximum tags to stop:** When the programming of the RFID tag fails, usually the word "VOID" is printed on the label. With this option you can specify how many tags can be programmed incorrectly. The option can be used as a precaution measure to prevent endless consumption of labels.

**Number of retries:** The number of times the printer will try to program the tag if first attempt fails. The parameter is sent to the printer with the rest of the data.

**Check for a valid tag:** Before the tag programming begins, the printer will verify if there is a proper RFID tag available in the smart label. The printer will also verify if the tag can be programmed at all. If the printer cannot check the currently selected RFID tag, the option will not be accessible.

**Verify data write:** Once the data has been encoded into the RFID tag, the printer will check if the written data is equal to the original value.

Electronic Article Surveillance (EAS) settings

EAS is not available for all printers and drivers. If your RFID Tag Settings do not include EAS Settings, you may need to update your printer driver or select a different printer. For more information, see your printer and driver documentation.

**Preserve original EAS setting:** The original EAS setting cannot be retrieved, but the default option assumes that the tag setting should remain unchanged.

**Enable EAS:** Enable Electronic Article Surveillance in the RFID tag. If this was the original setting, the tag will remain unchanged.

**Disable EAS:** Disable Electronic Article Surveillance in the RFID tag. If this was the original setting, the tag will remain unchanged.

**Permanently lock EAS tag setting:** Checking this box will permanently lock the chosen setting for the EAS. This lock cannot be undone.
Change Printer Settings

Change Common Printer Settings

When you start designing a label, tell ZebraDesigner for mySAP what printer to connect the label to. Each label file remembers the printer settings for the selected printer driver on the label.

This example shows you how to change the printing speed and darkness.

To change the printer settings, do the following:

1. From the File menu, select Printer Settings.
   The window with the printer settings opens.

2. Open the Options tab.

3. Change the Speed and Darkness options.

4. Click the OK button.

5. To save the label, click the button in the Standard toolbar, or from the menu select File > Save.

![Figure 26 • Printer Driver properties](image)

Note • Any changes in the printer settings dialog box will be saved to the label and applied to future print actions.
Change Dithering Options

Dithering is a process of converting color or gray scale pictures to black and white pictures that can be printed on thermal printers. Thermal printers normally cannot print color images and can either print a dot on the label or not. There are no intermediate shades of gray.

During the dithering process all colors and shades of gray in the picture are converted to black and white dots, creating the illusion of new colors and shades by varying the pattern of dots. Different shades of gray are produced by varying the patterns of black and white dots. There are no gray dots at all. In printing, dithering is usually called halftoning. Shades of gray are called halftones.

To change the dithering settings, do the following:

1. From the File menu, select Printer Settings. The window with the printer settings will open.
2. Open the Dithering tab.
3. Change the Dithering Type option to suit your needs. Look at the preview on the right side to see the result of your selection on the label.
4. Click the OK button.
5. Save the label by clicking the button in the Standard toolbar or selecting Save in the File menu.
Use Toolbars

Use the Standard Toolbar

Click on the buttons in the standard toolbar to execute the following actions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File" /></td>
<td>Create new label.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Open existing label.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Save currently opened label.</td>
</tr>
<tr>
<td><img src="image" alt="Scissors" /></td>
<td>Cut the selected objects to clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy the selected objects to clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste the objects from the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo last action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo last action.</td>
</tr>
<tr>
<td><img src="image" alt="Test Print" /></td>
<td>Access to the test print functionality. The label is quickly printed. You can review the positions of the objects. Click on the small arrow in the toolbar for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Access the export functionality. The label template is parsed through the Format Generation Wizard and prepared in a format for off-line printing.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Access to the zoom functionality. Click on the small arrow in the toolbar for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="View" /></td>
<td>Access to the view functionality. Click on the small arrow in the toolbar for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Open the help file.</td>
</tr>
</tbody>
</table>
Use the Variable Toolbar

The list box contains the variables available on the label. If you have selected some variable object, the list box displays variable linked to that object. If no object is selected, selecting a variable then clicking on the label places new text object and links it to the variable.

<table>
<thead>
<tr>
<th>Create variable</th>
<th>Create new variable using the <strong>Variable wizard</strong>. If you click on the small arrow, you can specify the type of the new variable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit variable</td>
<td>Edit the properties of the selected variable. <strong>Note</strong> • If you select the variable object, the variable linked to the object will be automatically listed in the list.</td>
</tr>
<tr>
<td>Delete variable</td>
<td>Delete the selected variable. <strong>Note</strong> • If you want to delete the variable, you must not use it on the label linked to label objects.</td>
</tr>
<tr>
<td>Import variables</td>
<td>Imports variables from a saved file.</td>
</tr>
<tr>
<td>Export variables</td>
<td>Exports variables on the label so that they can be imported to another label. <strong>Note</strong> • Only prompted variables will be exported.</td>
</tr>
<tr>
<td>Disconnect variable</td>
<td>Disconnects the variable from the object. The object becomes fixed, but will preserve the formatting. The number of characters in the object will be equal to the length of the variable. This might be useful when you are changing the data used with the label and want to conserve current positioning and formatting of the objects on the label.</td>
</tr>
</tbody>
</table>

There are several methods to connect a variable to some label element that should contain variable values.

- If you have the element already positioned on the label, select it, then choose the appropriate variable in the list.
- If the element is not already on the label, you can first select the variable in the list and then click the label where you want the element positioned. Text element will appear there and will be connected to the selected variable.
- You can click on the small arrow button next to the object icon in the toolbox, select the option **Use Existing Variable**, select the variable from the list and click on the label.

Variable toolbar always shows the name of the variable, which is attached to the current selected element. If there are two or more elements selected, and do not have the same variable attached to it, then the variable combo box is empty.
Use the Toolbox

To use the Toolbox, do the following:

1. Click on the icon in the **Toolbox** to select the object.

2. Move the mouse over the label. Notice how the cursor has changed.

3. To place the selected object, click on the label where you want to place the object.

Some objects have additional shortcuts on the right side of the icon. Using this shortcut, you can quickly create a new object with fixed content, create a new variable and connect it to the selected object, or connect the object to one already defined variable.
Use the Text Toolbar

You can use the text toolbar to quickly format the text objects on the label.

To format text objects, do the following:

1. Select the text object by clicking it.

2. Click the appropriate shortcut button in the text toolbar.

3. To change the font, select the appropriate font from the list in the list box.
   
   Note • You can limit the display of fonts in the list. You can list all fonts on the system, only graphic fonts (TrueType, opentype, type1, bitmap Windows fonts,) or only thermal printer resident fonts. Click on the two icons next to the list of fonts.

4. To change the size of the text, click on the list with font sizes and select the appropriate size. You can also click on the \( A^+ \) and \( A^- \) buttons that will increase/decrease the size of the font to the next size.
   
   Note • You can also change the fonts size directly on the label by resizing the text element with a mouse.

5. To format the text bold, italic, or underline, click on the appropriate formatting buttons.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Formats the selected text in bold style</td>
</tr>
<tr>
<td>I</td>
<td>Formats the selected text in italic style</td>
</tr>
<tr>
<td>U</td>
<td>Formats the selected text in underline style</td>
</tr>
</tbody>
</table>

6. To change the alignment of the text object, click on the appropriate alignment buttons.
   
   Note • These buttons are accessible only for multi-line text objects.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Aligns text to the left edge</td>
</tr>
<tr>
<td></td>
<td>Aligns text to the horizontal center</td>
</tr>
<tr>
<td></td>
<td>Aligns text to the right edge</td>
</tr>
</tbody>
</table>
Use the Design Toolbar

The design toolbar is used for:

- Changing color of the objects.
- Aligning objects.
- Rotating objects.
- Arranging objects.

Work with Objects

Define Objects

Define the Text Object

To place the text object on the label, do the following:

1. In the Toolbox, click the Text button.

2. Click the position on the label where you want to place the object. The Text Wizard dialog box opens.

3. Define the contents for the text object.

4. To advance to the next step of the wizard, click the Next button.

5. Follow the onscreen instructions in the next steps.

6. Click the Finish button.

   Note • To edit the object, select it, then double-click it. The wizard with properties appears.

Define the Bar Code Object

To place the bar code object on the label, do the following:

7. In the Toolbox, click the Bar Code button.

8. Click the position on the label, where you want to place the object. The Bar Code Wizard dialog box opens.

9. Define the contents for the bar code object.

10. To advance to the next step of the wizard, click on the Next button.

11. Follow the onscreen instructions in the next steps.

12. Click the Finish button.

   Note • To edit the object, select it then double-click it. The wizard with properties appears.
Define the Picture Object

To place the picture object on the label, do the following:

13. From the Toolbox, click on the Picture object.

14. Click on the label where you want to place the picture. The Open dialog box opens.

15. Browse for the picture on the hard disk, then click the Open button.

Note • To edit the object later, select it, and then double-click it. The wizard or dialog box with properties appears.

Define the Rectangle Object

To place the rectangle object on the label, do the following:

16. In the Toolbox, click the Rectangle button.

17. Click the position on the label where you want the upper-left position of the object to be set.

18. Drag in the bottom-right direction until the object size is correct.

19. The other method of positioning the rectangle object on the label is selecting the Rectangle tool and then clicking the label. A default-sized rectangle will appear, and you can resize it using handles around the object.

Note • If you want to draw a square, grab a handle on one of the rectangle corners, simultaneously press and hold the Shift key, then resize the rectangle. A square will be drawn. For more useful shortcuts available in the software, see Shortcuts.

20. To move a rectangle to a different position, select it and drag it elsewhere on the label.

Note • To edit the object, select it then double-click it. The dialog box with properties appears.

Define the Line Object

To place the line object on the label, do the following:

21. In the Toolbox, click on the Line object.

22. Define the line starting point by clicking the mouse at the start position.

23. Move the cursor to the end point while holding down the mouse button. A line will be drawn from the left to right side of the label.

Note • To draw a vertical line, click the starting point and then drag the cursor in the up-down direction.
Define the Ellipse Object

To place the ellipse object on the label, do the following:

24. In the Toolbox, click the Ellipse button.

25. Click the position on the label where you want the upper-left position of the object to be set.

26. Drag to the bottom-right direction until the object size is correct.

27. The other method of positioning the object on the label is selecting the Ellipse tool and then clicking the label. A default-sized ellipse will appear, and you can resize it using handles around the object.

   Note • To draw a circle, grab a handle on one of the ellipse corners, simultaneously press and hold Shift key, then resize the ellipse. A circle will be drawn. For more useful shortcuts available in the software, see Shortcuts.

28. To move an ellipse to a different position, select it and drag it elsewhere on the label.

Define the Inverse Object

To place the inverse object on the label, do the following:

29. In the Toolbox, click on the Inverse button.

30. Click the position on the label where you want the upper-left position of the object to be set.

31. Drag to the bottom-right direction until the object size is correct.

   Note • To draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold the Shift key, then resize the rectangle. A square will be drawn. For more useful shortcuts available in the software, see Shortcuts.

32. To move an inverse object to a different position, select it and drag it elsewhere on the label.
Use Text Wizard

Text Wizard

Figure 27 • First screen of Text Wizard

The Text Wizard guides you to define all parameters for the text object. You can define the object with fixed or variable contents.

**Fixed text**: Select this option if you would like to have a fixed non-changeable content of the object. If you select this option, you can enter the text directly in this dialog box.

**Variable text**: Select this option if you would like to have variable content in the object. Defining the content is defined in the next step.

**Font**: Currently selected font type is shown in this field.

- **Inverse**: Enable this option to use the text in inverse.

  **Note**: The option is not available for all fonts/printers.

- **Select button**: You can select different font types for this text object among available fonts in the system.
Text Wizard - Select Type of Variable Text

Select the type of the variable field you want to use. The next page of the wizard depends on your selection here.

Figure 28 • Text Wizard - Choosing variable text

Select the type of the variable field you want to use.

The next page of the wizard depends on your selection here.
Text Wizard - Time Field

Define the properties of the time field. The variable field will get the value from the computer’s clock.

![Text Wizard](image)

Figure 29 • Dialog box for Text Wizard when Time field option is chosen

Format: Select the format for the time from the list. You can also enter a custom format.

Time Offset: The time offset settings allow the time field to be offset from the system clock. Enter the duration for which you wish to increase or decrease the time on the label.

Preview: The printer will print the time as shown in the Preview field. This will allow you to see how the selected date format will look on the label.

Use the printer’s internal clock: Enable this option to recall the time information from the Real Time Clock (RTC) built in to the printer not the clock from the computer. The list of available time formats changes accordingly to the capabilities of the selected printer.

Note: You must format the current text object in an internal printer font to be able to use the printer’s internal clock option.

Only the printer internal date formats can be used with ZebraDesigner for mySAP software.
Text Wizard - Date Field

Define the properties of the date field. The field will get the value from the computer’s clock.

**Format:** Select the format for your date from the list. The list defines the formats available internally in the printer.

**Date offset:** You can add a certain number of days, months, or years to a current date and print that date instead of the current one.

**Preview:** The printer will print the date as shown on the Preview field. This allows you to see how the selected date format will look on the label.

**Use the printer’s internal clock:** Enable this option to recall the date information from the real time clock (RTC) built into the printer not the clock from the PC computer. The list of available date formats changes accordingly to the capabilities of the selected printer.

**Note:** You must format the current text object in an internal printer font to be able to use the **printer’s internal clock** option.

Only the printer internal date formats can be used with ZebraDesigner for mySAP software.

---

**Figure 30 • Dialog box for Text Wizard when Date field option is chosen**

Format: Select the format for your date from the list. The list defines the formats available internally in the printer.

**Date offset:** You can add a certain number of days, months, or years to a current date and print that date instead of the current one.

**Preview:** The printer will print the date as shown on the Preview field. This allows you to see how the selected date format will look on the label.

**Use the printer’s internal clock:** Enable this option to recall the date information from the real time clock (RTC) built into the printer not the clock from the PC computer. The list of available date formats changes accordingly to the capabilities of the selected printer.

**Note:** You must format the current text object in an internal printer font to be able to use the **printer’s internal clock** option.

Only the printer internal date formats can be used with ZebraDesigner for mySAP software.
Text Wizard - RFID Tag Contents

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID tag has a unique ID number that was programmed into the tag during the manufacturing process. The Unique number cannot be altered, but the RFID-enabled printer can read it.

RFID tag Unique ID functionality allows you to read the unique ID number from the RFID tag and use the content with the selected bar code object. When the label is printed, the printer will first read the unique ID from the tag and then immediately use the value with the bar code object.

RFID tag Unique ID can only be used with the bar code objects that are printed as internal printer objects. You must format the bar code object to use internal fonts not TrueType fonts.

Figure 31 • RFID Tag dialog

Selected RFID tag: Select the tag from the list.

Note • Only tags supported by the selected printer are listed. If you want to use some other tag type make sure you have selected the proper Zebra printer driver.

Data Format: Select the format of the data.

Preview (WYSIWYG only): Because RFID tag Unique ID information is not returned to the labeling software, you do not see the actual data. Enter the data in a format similar to the format encoded in the RFID tag. This information will be used for preview on the label only.
Text Wizard - Prefix and Suffix

The variable object can have prefix and suffix values. The prefix text is placed in front of the variables value. The suffix text is placed at the end of the variables value.

Prefix and Suffix

Specify prefix and suffix for your element.

Prefix string will be placed in front of the data value.
Suffix string will be placed after the data value.

Prefix: 

Suffix: 

To complete the Wizard click Finish.

Figure 32 • Setting Prefix and Suffix string for the variable text element

Note • If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has a value set. If the variable is empty, the prefix/suffix will not be printed.

Note • When you use the printer Real Time Clock for date or time fields, the length of prefix and suffix cannot exceed 31 characters.
Use Bar Code Wizard

Bar Code Wizard

Figure 33 • First page of Bar Code Wizard

The Bar Code Wizard guides you to define all parameters for the text object. You can define the object with fixed or variable contents.

Fixed bar code data: If you would like to have fixed non-changeable content for the text object, select this option. If you select this option, you can enter the text directly in this dialog box.

Variable bar code data: If you would like to have variable content for the text object, select this option. Defining the content is defined in the next step.

Note • When entering values for RSS composite bar codes, you need to provide the value for the linear and composite (2D) parts at the same time.

Use the following syntax for entering values for RSS composite bar codes. The pipe character (|) is used to distinguish between the components.

Note • Syntax: <linear part>|<composite part>

Example • 12345|description

Bar Code Type: Click on the Define button to select the bar code type you want to use on the label.
Bar Code Wizard - Select Type of Variable Bar Code

Bar Code Wizard - Date Field

Define the properties of the date field. The variable field will get the value from the computer’s clock.

Format: Select the format for your date from the list. You can also enter a custom format.

**Date offset**: You can add a certain numbers of days, months, or years to a current date and print that date instead of the current one.

**Preview**: The printer will print the date as shown in the Preview field. You can see how the selected date format will look on the label.

**Use the printer’s internal clock**: Enable this option to recall the date information from the real time clock (RTC) built in to the printer not the clock from the PC computer. The list of available date formats changes accordingly to the capabilities of the selected printer.

**Note**: You must format the current text object in internal printer font to be able to use the option *Use the printer’s internal clock*.

Only the printer internal date formats can be used with ZebraDesigner for mySAP software.
Bar Code Wizard - Time Field

Define the properties of the time field. The variable field will get its value from the computer clock.

Format: Select the format for the time from the list. You can also enter a custom format.

Preview: The printer will print the time as shown in the Preview field. You can see how the selected date format will look on the label.

Use the printer’s internal clock: Enable this option to recall the time information from the Real Time Clock (RTC) built in to the printer not the clock from the PC computer. The list of available time formats changes accordingly to the capabilities of the selected printer.

Note • You must format the current text object in internal printer font to be able to use the option Use the printer’s internal clock.

Only the printer internal date formats can be used with ZebraDesigner for mySAP software.

Bar Code Wizard - RFID Tag Contents

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID tag has a unique ID number that was programmed into the tag during the manufacturing process. The Unique number cannot be altered, but the RFID-enabled printer can read it.

RFID tag Unique ID functionality allows you to read the unique ID number from the RFID tag and use the content with the selected bar code object. When the label is printed, the printer will first read the unique ID from the tag and then immediately use the value with the bar code object.

RFID tag Unique ID can only be used with the bar code objects that are printed as internal printer objects. You must format the bar code object to use internal fonts not TrueType fonts.

Selected RFID Tag: Select the tag from the list.

Note • Only tags supported by the selected printer are listed. If you want to use some other tag type make sure you have selected the proper Zebra printer driver.

Read Source: Select the source of the RFID data. Click on the Detailed button to define the data from the RFID tag you want to use.

Note • The Detailed button is not accessible for all RFID printers.

Data Format: Select the format of the data.

Preview (WYSIWYG only): Because the RFID tag’s Unique ID information is not returned to the labeling software, you do not see the actual data. Enter the data in a format similar to the format of the RFID tag. This information will be used for preview on the label only.
Bar Code Wizard - Prefix and Suffix

The variable object can have prefix and suffix values. The prefix text is placed in front of the variable’s value. The suffix text is placed at the end of the variable’s value.

Note • If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has a set value. If the variable is empty, the prefix/suffix will not be printed as well.

Note • When you use the printer Real Time Clock for date or time fields, the length of prefix and suffix cannot exceed 31 characters.

Use Graphics Wizard

Graphics Wizard

The graphics wizard helps you place the image on the label. You can place fixed image or variable image on the label. If you use variable picture, the selected variable will have to provide the path and filename of the picture.

Note • The graphics wizard is not available with all ZebraDesigner editions. If there is no support for variable graphics in your ZebraDesigner software, the graphics wizard will not start. But you will be able to browse for some fixed graphics file from the disk.

Figure 35 • The first step of the Graphics Wizard

Fixed: Select this option if you will use a fixed picture on your label. Click the Browse button and point to the picture you want to use.
Graphics downloaded to printer: Click this option, if the selected picture has already been downloaded to the printer using the application ZebraDesigner Font and Graphics Downloader. When the label is exported, the generated file will include the reference to the downloaded picture and not the whole picture.

Variable: Select this option, if one of the variables provides the path and name of the picture. You must select the appropriate variable in the next step.

Graphics Wizard - Variable Selection

If you want to use variable pictures on the label, select the appropriate variable in the list. The variable must provide the name of the picture.

Note • If no variables are available, click the New button and define a new variable.

Bar Code Type Selection

Settings for Advanced Bar Codes

PDF 417 2D Code

General tab

Y expansion factor
This option defines the height of the bar code symbol.

Security tab

According to the standard, you can select among 9 levels of security. Higher security levels allow more reliable reading regardless of errors, but the bar code symbol is bigger.

Truncated bar codes can be used where label damage is unlikely and there is no demand for a high level of security. The truncated symbol is smaller.

Aspect Ratio
It is the ratio between the number of columns and the number of rows.

Contents

PDF 417 code can encode:

• Full 128 ASCII character set
• All 128 Extended ASCII characters
• 8-bit binary data
DataMatrix Bar Code

**General tab**

*Y expansion factor*
This option defines the height of the bar code symbol.

*Aspect Ratio*
It is the ratio between the number of columns and the number of rows. Select one of the values from the drop down menu.

**Details tab**

*ECC Type*
Error Correction Codes define the security level. You can select one from the standard levels in the pull-down menu.

*Format ID*
This option defines which character set will be used in the bar code. You can select one of the formats with the following filter.

<table>
<thead>
<tr>
<th>Format ID</th>
<th>Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 and 11</td>
<td>0..9, space</td>
</tr>
<tr>
<td>02 and 12</td>
<td>A..Z, space</td>
</tr>
<tr>
<td>03 and 13</td>
<td>A..Z, 0..9, space</td>
</tr>
<tr>
<td>04 and 14</td>
<td>A..Z, 0..9, space,.,/-</td>
</tr>
<tr>
<td>05 and 15</td>
<td>7-bit ASCII lower part (from 0 to 127)</td>
</tr>
<tr>
<td>06 and 16</td>
<td>all</td>
</tr>
<tr>
<td>07 and 17</td>
<td>7-bit ASCII</td>
</tr>
</tbody>
</table>

The formats from 1 to 7 allow a data length up to 500 characters, while formats from 11 to 17 allow up to 2000 characters.

*Border Size*
Factors from 1 to 15 set the dimension of the border in the shape of the character L.

Data Matrix can encode:
- Full 128 ASCII character set
- All ISO characters
- All EBCDIC characters
MaxiCode 2D Code

**General tab**

**Y expansion factor**
This option defines the height of the bar code symbol.

**Details tab**
When the option **Structured** is not selected, the content of the bar code is optional.

For Structured bar code you may encode only standard contents.
Edit Bar Code Dialog Box

This dialog box is displayed when you click the Define button on the bar code dialog box. On this dialog box you specify the type of bar code you want to use on the label and all additional advanced settings: how the bar code should be generated, if the check digit should be automatically calculated or not, and various other options. If the Enable preview check box is checked, a preview of a resulting bar code is displayed on the right side of the dialog box.

When you are satisfied with the bar codes properties, confirm the changes you made by clicking the OK button or reject them and keep previous settings by clicking the Cancel button.

The Edit Bar Code dialog box has several pages (tabs).

General Tab

On this tab, you can select the bar code type you want to use and the properties of the bar code.

Figure 36 • Edit Bar Code dialog box – General tab

**Type of bar code:** The required bar code symbology is selected from the tree list of available bar codes.

Symbol height: The height dimension of a bar code can be specified either by entering a value here or by resizing the bar code symbol directly on the label.

**X-Expansion factor:** The expansion factor defines the width of the bar code symbol.

**Ratio:** This is the ratio between narrowest and widest bar in the bar code. It is locked for the majority of bar codes, but it can be changed for some.
**Base object width:** Shows the width of the narrowest bar in the bar code.

**Print bar code as graphics:** Select if bar code should be converted to a picture and sent to the printer as image or should the printer print bar code as an internal element. Printing internal bar codes will speed up label printing because less data must be transferred to the printer.

**Note** • If the printer does not support the selected bar code internally, the option **Print bar code as graphics** will not be available. All office printers will print bar codes as pictures.

**Check Digit Tab**

This tab is used to specify if you want to use the check digit in the bar code or not. This option can only be modified for the bar codes that allow you to enable and disable the check digit.

Some bar code standards include the check-digit by definition and it cannot be omitted. An example of such bar codes are EAN and UPC bar codes, where the check digit cannot be disabled at all. But some codes allow you to freely enable/disable the check-digit.

**Note** • We recommend that you always include the check digit character in the bar code. It will increase the scanning reliability.

![Edit Bar Code dialog box – Check digit tab](image)

You can choose whether you want to input the check digit value, or let the program calculate it for you:

**Auto-generate check digit:** Check digit is calculated by the software. You enter the bar code data only. For example: when using EAN-13 bar code, you enter the first 12 digits; check digit on the 13th place will be calculated and added automatically.
Verify the provided check digit: Use this command when you want to enter the value for the check-digit. At print time, the entered check digit will be verified for validity.

Enable custom check digit algorithm: You can set a custom algorithm for calculating the check digit. Click on the button Select to choose the algorithm.

Human Readable Tab

On this tab, you can set the options regarding position and format of the bar code interpretation.

No interpretation: Bar code object does not have any human interpretation.

Below bar code: All data encoded in the bar code is placed beneath the bar code symbol as human readable characters.

Above bar code: All data encoded in the bar code is placed above the bar code symbol as human readable characters.

Font: Using the Font button, you can choose the font for auto-translation text. The option Auto font scaling will adjust the font of the auto translation text to the size of the bar code.

Note • You can format the font for human interpretation only if the bar code is printed as a graphic. When printing the bar code as an internal printer object, the printer will print the interpretation using resident built-in fonts.

Contents mask sets the custom format of the human interpretation.

Figure 38 • Edit Bar Code dialog box – Human readable tab
Details Tab

On this tab, you can define advanced settings for the bar code.

**Note** • Not all of these options are available for all bar codes and printers.

**Include quiet zones:** Check this field if you want the bar code to have some white space in the front and in the end for increased readability.

**Descender bars:** Some bars of a bar code will be longer than others. This is typically used with EAN and UPC bar codes that have longer bars in the beginning, in the middle and in the end of the bar code.

**Mirror horizontally/mirror vertically:** The bar code can be mirrored vertically and horizontally. The bar code will usually have to be printed as a graphic for this option to be accessible.

**Intercharacter gap:** Some bar codes allow you to change the gap between characters in the bar code (e.g. Code-39).

**Include EAN white space:** Before and after the bar code a white space is inserted or not, as desired. It indicates the width of the bar code. If you put any other object in the area of the bar code, it will reduce the readability of the bar code. This option is valid only for EAN bar codes.

![Edit Bar Code](image)

**Figure 39 • Edit Bar Code – Details tab**
Supported Bar Code Types

<table>
<thead>
<tr>
<th>Bar code Group</th>
<th>Bar code Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAN and UPC</td>
<td>EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), EAN.UCC 128, SSCC, Bookland, Addon 2, Addon 5</td>
</tr>
<tr>
<td>RSS</td>
<td>Linear RSS symbologies&lt;br&gt; RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded&lt;br&gt; Composite RSS symbologies&lt;br&gt; RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, EAN-8, EAN-13, EAN.UCC 128 &amp; CC-A/B, EAN.UCC 128 &amp; CC-C</td>
</tr>
<tr>
<td>Two-dimensional</td>
<td>2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR, MicroQR, Codablock F, MicroPDF, InfoGlyph</td>
</tr>
</tbody>
</table>

Select Objects

To select the object on the label, do the following:

1. In the Toolbox, click the Select button.
2. Click on the object on the label that you want to select.

To select two or more objects, press the Shift key, and hold down, while clicking the object with a mouse.

The objects can be selected, cut, copied, pasted, and edited with the right mouse button. If you click the right mouse button on the object, the menu shows all the available commands. Note that these commands are equivalent to correspondent menu commands.

You can also change the anchoring point of a selected object by holding Ctrl while clicking the placeholders (corners of the bounding box) of the object.
Edit Objects

To edit the properties of the object, do the following:

1. Double-click the object on the label.
   The dialog box with object properties opens.
   Note • You can also press the Enter key while the object is selected.

2. Make modifications to the object properties.

3. Click the Finish button.

Move Objects

To move the object on the label, do the following:

1. Select the object.

2. Click on the object with the left mouse button.

3. Hold the mouse key down.

4. Move the position of the cursor on the screen.
   The object will move with the cursor.

Align Objects

To align object on the label, do the following:

1. Select the objects that you want to align.
   Note • All objects are aligned relative to the first selected object.

2. Click appropriate buttons in the Design Toolbar to align selected objects to each other. If Align toolbar is not visible (by default it is located on the very right side of the window), enable the Design toolbar in the Toolbar option in the View menu.
   Note • Alternatively you can right-click the objects on the label and select Align command.
You can align objects to:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
</tr>
<tr>
<td></td>
<td>Right</td>
</tr>
<tr>
<td></td>
<td>Horizontal center</td>
</tr>
<tr>
<td></td>
<td>Top</td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
</tr>
<tr>
<td></td>
<td>Vertical center</td>
</tr>
</tbody>
</table>

You can also distribute objects evenly, so that spacing between them is equal:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horizontally</td>
</tr>
<tr>
<td></td>
<td>Vertically</td>
</tr>
</tbody>
</table>

**Note** • If you hold the CTRL key while clicking the buttons, the selected objects are aligned relative to the label and not to the first selected object.

**Resize Objects**

**To resize the object on the label, do the following:**

1. Select the object.
   
   The selected object is framed with a rectangle.

2. Click on one of the small rectangles in the corners of the rectangle.

3. Hold the mouse key down.

4. Move the position of the cursor on the screen.
   
   The object will resize with the cursor.
Rotate Objects

To rotate the object, do the following:

1. Select the object.

2. In the Design Toolbar, click the button.
   The object will be rotated 90° clockwise.

Note • If the Design toolbar is not visible in the application, enable the toolbar in the Toolbars section in the View menu.

Supported Graphics Formats

The following graphical formats are supported:

<table>
<thead>
<tr>
<th>File extension</th>
<th>Graphics type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP, DIB, RLE</td>
<td>Windows Bitmap</td>
</tr>
<tr>
<td>GIF</td>
<td>CompuServer Bitmap</td>
</tr>
<tr>
<td>JPG, JPEG, JPE</td>
<td>JPEG Bitmap</td>
</tr>
<tr>
<td>TIFF, TIF, FAX, G3N, G3F</td>
<td>TIFF Bitmap</td>
</tr>
<tr>
<td>PNG</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>WMF</td>
<td>Windows Metafile</td>
</tr>
<tr>
<td>EMF</td>
<td>Enhanced Windows Metafile</td>
</tr>
<tr>
<td>TGA, TARGA, VDA, ICB, VST, PIX</td>
<td>Targa Bitmap</td>
</tr>
<tr>
<td>PXM, PPM, PGM, PBM</td>
<td>Portable Pixmap, GreyMap, BitMap</td>
</tr>
<tr>
<td>JP2</td>
<td>JPEG2000</td>
</tr>
<tr>
<td>J2K, JPC</td>
<td>JPEG2000 Code Stream</td>
</tr>
<tr>
<td>PCX</td>
<td>Paintbrush</td>
</tr>
</tbody>
</table>
Work with Variable Data

Dynamic Data Overview

You may want to print labels on which the data changes for each label, for example, serial numbers, date, and time. To accommodate changing data, ZebraDesigner for mySAP can be used to format labels using the variable fields. Variable fields can be used with text and barcode objects.

There are several types of variables you can choose. The data for the variables must be provided before label can be exported:

- You must provide the values for the variables before the label can be printed.
- The data is provided from the printer’s clock for the date and time fields (internal printer RTC).
- The data is provided from the RFID tag embedded into the label (RFID tag Unique ID).

Create Single-Line Variable

As the name suggest, you can use single-line variable in one line of text on the label.

To create a single-line variable on your label, do the following:

1. Make sure the Variable Toolbar is visible. If it is not, select View > Toolbars > Variable.
2. In the Variable Toolbar, click the button. The Variable Wizard will start.
3. Enter the name of the variable. Use a descriptive name. It will help you know what is the contents of the variable.
4. Click the Next button.
5. Enter the Sample data. When you will link your variable to the label object, the sample data will be used for the contents of the object. The sample data is shown during label design only.
   - Note • When you will print the label, the variable will use the data you provide, not the sample data.
6. Click the Finish button.

Create Multi-Line Variable

As the name suggest, you can use multi-line variable with more lines of text in the text object on the label. The variable can contain as many characters in each line as you specify. The total amount of allowable characters is number of characters per line times number of lines. For example, if you allow 20 characters in a line and have 5 lines, the total number of characters is 100.
To create a single-line variable on your label, do the following:

1. Make sure the Variable Toolbar is visible. If it is not, select View > Toolbars > Variable.

2. In the Variable Toolbar, click the button. The Variable Wizard will start.

3. Enter the name of the variable. Use a descriptive name. It will help you know what is the contents of the variable.

4. Click the Next button.

5. Enable the option Multiline Variable.

6. Enter the Sample data.
   When you will link your variable to the label object, the sample data will be used for the contents of the object. The sample data is shown during label design only. Use Enter key to advance to the next line of text.
   
   Note • When you will print the label, the variable will use the data you provide, not the sample data.

7. Click the Finish button.

Using Printer Real Time Clock (RTC)

When the printer selected on the label has a built-in Real Time Clock (RTC), you can use the time or date fields from the Real Time Clock with text objects on the label. The available time and date formats are defined in the printer driver.

To use the time field from the printer RTC on the label, do the following:

1. In the Toolbox, click the button.

2. Click the position on the label, where you want to place the object. Text Wizard dialog box will open.

3. Enable the Variable text option.

4. Click the Next button.

5. Select the Time Field option.

6. Click the Next button.

7. Select the appropriate time format from the list. Printer driver provided the software with the list of available time formats. You cannot define your own time format, they are determined by the printer functionality.

8. Click the Finish button.

   Note • When you are using a prefix and suffix with the Real Time Clock field on the label, make sure that the length of the prefix and suffix does not exceed 31 characters.
   
   When you are using a linked field and are merging a Real Time Clock field with other fields, make sure that the length of fields surrounding Real Time Clock field does not exceed 31 characters.
Use Variable Wizard

Variable Wizard

Use the variable wizard to create and manage the variables in the label file. When you assign value to the variables the same value will be used with all objects on the label that are linked to the variable.

The variables can be linked to Text and Bar Code objects.

To create a variable follow on-screen instructions in the variable wizard.

Define Variable Name

You can define the variable name and quantity information in this step of the variable wizard.

**Variable Name:** Type in the variable name. The variable name will be included in the exported label. Make sure you use the proper variable name that is recognized by the Format Generation Wizard.

**Note •** Make sure you include the proper characters for the variable left and right tag characters. These characters define the beginning and end of the variable name. Use the tag characters as suggested by ZebraDesigner for mySAP software. For example; for the left tag character % can be suggested, for right tag character & can be suggested.

Define Variable Properties

You can define the variable data properties in this step of the variable wizard.

**Sample data:** Enter the appropriate data for the variable. The entered data will be used for design and preview functionality. You will assign the variable with its proper value outside of ZebraDesigner for mySAP software.

**Multiline Variable:** Click this option, if you want to enable the multi-line functionality for the variable. You will be able to enter more than just one line of sample data.

**Note •** To move to the next line of text press the key combination Ctrl+Enter.

**Maximum number of characters:** Define the maximum number of characters the variable can occupy. The number defined here must correspond to the external application that will actually set variable values.

**Number of lines:** Define the multi-line variable. Enter the number of lines the variable can occupy.

To find out the total number of characters the variable can contain multiply the maximum number of characters in a line with number of lines. For example: if you have 10 characters in one line and have defined 3 lines of data, 30 characters can be set to the variable.
Define Script

You can define a script that will be included in the exported label format. This feature is optional.

Format Generation Wizard in ZebraDesigner for mySAP will include the variable in the proper formatting in the exported label file. You can override the default settings and include some special parameters or commands with the variable name. Define a script and include not only the variable name in the script, but other parameters and commands using the Zebra Programming Language (ZPL).

Note • This feature is for advanced users only. You have to be familiar with the ZPL to successfully use the script option.

Use script: Click this option to enable the script option. Write your script in the provided space. Make sure you include the variable name in the script.
Notes •

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________
5

Export Labels

Contents
Test Print Labels ................................................. 98
Format Generation Wizard .................................. 99
  Export to Printer ........................................... 99
  Save File on Disk ......................................... 101
  Save File on Disk and Download Objects to Printer ...... 104
  Use Current Location ..................................... 105
  Send to IP Address ....................................... 105
  Search Types ............................................. 107
  Optimize the Printing Speed ............................. 114
Test Print Labels

To test print the label, do the following:

1. Make sure you have your printer connected to the computer.

2. Make sure the printer is online and available for printing.

3. Click on the icon in the Standard toolbar to quickly print your label to the printer.

Note • The variables will be assigned with a default values, but you will get an overview, if the label is designed correctly and the objects fit on the label. You also see how the pictures are processed and printed. When you place a picture on the label, in design mode it is always shown in color-depth as defined in the picture.

When printing the labels, the preview of the pictures depends on the dithering option set in the printer driver. All color pictures (except WMF and EMF files) are converted to monochrome images. The illusion of colors and shades of grey is accomplished by varying the pattern of dots. More dots close together will provide a darker shade of grey.

The test print of the label will show pictures in the same way as they will be printed according to the dithering setting. If the picture is not printed as you would like to print it, change the dithering setting in the printer driver.
Format Generation Wizard

Export to Printer

To verify the printout of your label, from the menu, select **File > Test Print**. When you are satisfied with the designed label, you can export the label to the printer. During the export process, ZebraDesigner for mySAP™ Business Suite runs the Format Generation Wizard and converts the label format to ZPL.

The generated file includes commands from the Zebra Programming Language (ZPL) and is ready to be used in the printer for off-line printing.

**Note** • Off-line printing is a term that describes the type of label printing where the label design application is not available at print time. Usually the label format is stored in the memory of the printer and can be recalled. Off-line printing support is great for print requirements where the PC computer cannot be included in the label printing process either because of unacceptable working conditions or logistic issues. Off-line printing also provides faster label printing because all variable objects on the label use internal printer functionality.

**To export the label to printer, do the following:**

1. From the menu, select **File > Export to Printer**.

The *Download Objects* dialog box opens.

2. Select the option you want.

![Format Generation Wizard dialog box](image)
3. Click **Next**. The *Printer Object Location* dialog box opens.

![Printer Object Location](image)

**Note:** All objects stored in RAM (R:) will be lost when the printer is switched off.

4. Select the Printer Storage Location you want. The memory types include:
   - A-Flash = Option Flash memory
   - B-Flash = Flash memory card (PCMCIA)
   - E-Flash = internal Flash memory
   - R-DRAM = volatile memory

5. Type in a format name.

6. Click **Next**.

**Note:** Your choice in the *Download Objects* dialog box will determine which dialog box follows. For more detailed information and screenshots, click on the links below.
   - SAPscript file on disk
   - Create SAPscript file on disk and download objects to printer(s)
Save File on Disk

If you chose **Create SAPscript file on disk** in the *Download Objects* dialog box, you will see the following dialog box:

![Format Generation Wizard dialog box](image)

In the *File Destination* dialog box you can navigate to where you want the file saved.
To choose a file destination, do the following:

1. Click **Browse**. The *Browse for Folder* dialog box opens.

2. Navigate to the path where you want the file sent.

3. Click **OK**. The *Browse for Folder* dialog box closes and you return to the *File Destination* dialog box. The Enter Destination Path text box is populated with the destination you selected in the *Browse for Folder* dialog box.

4. Click **Next**. The *Format Generation Wizard* dialog box opens. From this dialog box you can:

   - **Send File**: the Send File button sends your file to the selected path
   - **Cancel**: the Cancel button stops the file from being sent
   - **Help**: the Help button opens help for the Format Generation Wizard
5. Select **Send File**. The *Destination* dialog box opens.

In the *Destination* dialog box you can select where you want to send the file(s).

These are your options:

- **Use Current Location**
- **Send to IP Address**
Save File on Disk and Download Objects to Printer

If you chose **Create SAPscript file on disk and download objects to printer(s)** in the *Download Objects* dialog box, you will see the following dialog box:

In the *Destination* dialog box, you can select where you want to send the file(s).

These are your options:

- Use Current Location
- Send to IP Address
Use Current Location

If you choose **Use Current Location**, and click **Next**, this confirmation dialog box opens:

To send the files to the printer using the port that the ZebraDesigner driver is using, do the following:

- Click **Send File**.

  **Note** • If you click **Cancel**, the file will not be sent.

Send to IP Address

If you choose **Send to IP Address**, and click **Next**, the **Select Network Destination** dialog box opens.

To complete the IP address search, you can enter an IP address or an address range.

**Examples:**

- To send a discovery request to 10.3.5.20 only, enter: 10.3.5.20
- To send a discovery request to printers in the address range of 10.3.5.20 through 10.3.5.47, enter 10.3.5.20-47

The IP address search avoids sending unnecessary traffic to non-printing devices.
To send to an IP address, do the following:

1. Enter either a valid IP Address or Network Name.

   **Note** • In the **Enter an IP Address** field, type in a valid IP address, or a partial address using an *.

2. Click **Next**. This confirmation dialog box opens:

   **Note** • To search for a print server, see **Search Types**.

3. Click **Send File**. The file is sent.

4. Click **Finish**.
Search Types

Search Type

If you select Search Print Server from the Select Network Destination dialog, the Search Type dialog opens.

In the Search Type dialog box you have the option to search for Zebra print servers using the following methods:

- Local Broadcast
- Subnet Search
- Directed Broadcast
- Multicast
- IP Address xxx.xxx.xxx.xxx (-xxx)

To choose one of the options, do the following:

- Select the option you want.
- Click Next.
Local Broadcast

Local broadcasts send a discovery request to the local broadcast address of 255.255.255.255. This request finds printers in the same local network as the requesting computer.

The local broadcast search populates itself.

To perform a local broadcast search, do the following:

1. From the Select Network Destination dialog box, click Search Print Server.

2. In the Search Type dialog box, enable Local Broadcast. The Value field is automatically populated.

3. Click Add. The Value field is added to Search type.

4. Click Next. The Select Print Server dialog box opens.

5. Using the buttons between the two panels, select the print servers you want.

6. When you are finished, click Next. This confirmation dialog box opens: Objects have been saved to file. Test file can now be sent for test print.

7. To send, click Send File.
Subnet Search

The subnet search sends a discovery request to each address in the specified subnet. This feature is useful for networks that prevent broadcast packets from passing across routers. The Subnet search requires you to type in the first three subnet octets.

Example • A request to 192.168.2.* sends a request to: 192.168.2.1 through 192.168.2.254.

To perform a subnet search:

1. From the Search Type dialog, enable Subnet xxx.xxx.xxx.*.
2. In the Value field, type the first three subnet octets. Then type an *.
3. Click Add, and then click Next. The Select Print Server dialog opens.
4. Using the buttons between the two panels, select the print servers you want.
5. When you are finished, click Next.

This confirmation opens:

![Format Generation Wizard](image)

6. To send, click Send File.

**Directed Broadcast**

Directed broadcasts send a discovery request to the broadcast address of the specified subnet.

**Note** • If a broadcast search does not work, the broadcast packets might be disabled across routers. Try multicast or subnet search.

**Example:** The directed broadcast search requires you to type in the first three subnet octets, followed by 255, such as 192.168.2.255.

To perform a Directed Broadcast search:

1. In the *Search Type* dialog, enable **Directed Broadcast**. The *Value* field is automatically populated.
2. Click Add.
3. Click **Next**. The *Select Print Server* dialog opens.

4. Using the buttons between the two panels, select the print servers you want.

5. When you are finished, click **Next**.

   This confirmation opens:

6. To send, click **Send File**.
Multicast

Multicast uses the multicast address to send a discovery address to all Zebra printers across as many routers as the hop count specifies. A multicast search may return a large number of printers in some installations.

On some routers, this feature might be disabled. See your network administrator to determine if a search failure was due to this feature being disabled.

1. In the Search Type dialog, enable Multicast (Hops). The Value field is automatically populated.

2. Click Add.

3. Click Next. The Select Print Server dialog opens.

4. Using the buttons between the two panels, select the print servers you want.

5. When you are finished, click Next.

This confirmation opens:
6. To send, click **Send File**.

**IP Address xxx.xxx.xxx.xxx (−xxx)**

The IP Address Search avoids sending unnecessary traffic to non-printing devices. You can search for a range of IP addresses using this option.

1. In the **Search Type** dialog, enable **IP Address xxx.xxx.xxx.xxx (−xxx)**.
2. Click **Add**.
3. Click **Next**. The **Select Print Server** dialog opens.

4. Using the buttons between the two panels, select the print servers you want.
5. When you are finished, click **Next**.

This confirmation opens:

6. To send, click **Send File**.
Optimize the Printing Speed

There are many factors that affect the printing speed. By following the guidelines below you can dramatically increase the speed of printing:

- Use the printer’s internal fonts instead of Windows’ true-type fonts. True-type fonts must be sent to the printer as graphics and the size of the file is much bigger (kilobytes). When using internal fonts, only the text is sent to the printer (bytes). If you must use true-type fonts, use the ZebraDesigner Font and Graphics Downloader program, to download these fonts to the printer’s memory and access these fonts as internal printer fonts (only available if your printer supports download of the fonts).

- When using bar codes, make sure that you do not print bar codes as graphics if your printer supports printing bar codes.

Set the printing speed to a higher value (if your printer supports it). Note that setting the printing speed usually affects the quality of printing. The higher the speed, the lower the quality.
6

Technical Support

Contents

Online Support ................................................................. 116
Contact Information .......................................................... 117
Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions (FAQ) under the Support section on the Zebra Web site. If you cannot solve the problem on your own, please contact your local vendor or representative offices listed in the topic Contact Information.
## Contact Information

Technical Support via the Internet is available 24 hours per day, 365 days per year.

**Web Site:** [www.zebra.com](http://www.zebra.com)

**E-mail Back Technical Library:**
- E-mail address: emb@zebra.com
- Subject line: Emaillist

**Self Service Knowledge Base:** [www.zebra.com/knowledgebase](http://www.zebra.com/knowledgebase)

**Online Case Registration:** [www.zebra.com/techrequest](http://www.zebra.com/techrequest)

### Which Department Do You Need?

<table>
<thead>
<tr>
<th>Department</th>
<th>The Americas</th>
<th>Europe, Middle East, and Africa</th>
<th>Asia Pacific and India</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regional Headquarters</strong></td>
<td>Zebra Technologies Corporation 475 Half Day Road, Suite 500 Lincolnshire, IL 60069 USA  T: +1 847 634 6700 Toll-free +1 866 230 9494 F: +1 847 913 8766</td>
<td>Zebra Technologies Europe Limited  Dukes Meadow Millboard Road Bourne End Buckinghamshire, SL8 5XF United Kingdom  T: +44 (0) 1628 556000 F: +44 (0) 1628 556001</td>
<td>Zebra Technologies Asia Pacific Pte. Ltd.  120 Robinson Road #06-01 Parakou Building Singapore 069013  T: +65 6858 0722 F: +65 6885 0838</td>
</tr>
<tr>
<td><strong>Technical Support</strong></td>
<td>T: +1 877 ASK ZEBRA (275 9327) F: +1 847 913 2578  Hardware: <a href="mailto:ts1@zebra.com">ts1@zebra.com</a> Software: <a href="mailto:ts3@zebra.com">ts3@zebra.com</a>  Kiosk printers:  T: +1 866 322 5202 E: <a href="mailto:kiosksupport@zebra.com">kiosksupport@zebra.com</a></td>
<td>T: +44 (0) 1628 556039 F: +44 (0) 1628 556003 E: <a href="mailto:Tseurope@zebra.com">Tseurope@zebra.com</a></td>
<td></td>
</tr>
<tr>
<td><strong>Repair Service Department</strong></td>
<td>T: +1 877 ASK ZEBRA (275 9327) F: +1 847 821 1797 E: <a href="mailto:repair@zebra.com">repair@zebra.com</a>  To request a repair in the U.S., go to <a href="http://www.zebra.com/repair">www.zebra.com/repair</a></td>
<td>T: +44 (0) 1772 693069 F: +44 (0) 1772 693046  New requests:<a href="mailto:.ukrmna@zebra.com">.ukrmna@zebra.com</a> Status updates: <a href="mailto:repairupdate@zebra.com">repairupdate@zebra.com</a></td>
<td>T: +65 6858 0722 F: +65 6885 0838 E: China: <a href="mailto:tschina@zebra.com">tschina@zebra.com</a> All other areas: <a href="mailto:tsasiapacific@zebra.com">tsasiapacific@zebra.com</a></td>
</tr>
<tr>
<td><strong>Technical Training Department</strong></td>
<td>T: +1 847 793 6868  T: +1 847 793 6864  F: +1 847 913 2578 E: <a href="mailto:ttamerica@zebra.com">ttamerica@zebra.com</a></td>
<td>T: +44 (0) 1628 556000 F: +44 (0) 1628 556001 E: <a href="mailto:Eurtraining@zebra.com">Eurtraining@zebra.com</a></td>
<td>T: +65 6858 0722 F: +65 6885 0838 E: China: <a href="mailto:tschina@zebra.com">tschina@zebra.com</a> All other areas: <a href="mailto:tsasiapacific@zebra.com">tsasiapacific@zebra.com</a></td>
</tr>
<tr>
<td><strong>Inquiry Department</strong></td>
<td>T: +1 877 ASK ZEBRA (275 9327) E: <a href="mailto:inquiry4@zebra.com">inquiry4@zebra.com</a></td>
<td>T: +44 (0) 1628 556037 F: +44 (0) 1628 556005 E: <a href="mailto:mseurope@zebra.com">mseurope@zebra.com</a></td>
<td>E: China: <a href="mailto:GCmarketing@zebra.com">GCmarketing@zebra.com</a> All other areas: <a href="mailto:APACCchannelmarketing@zebra.com">APACCchannelmarketing@zebra.com</a></td>
</tr>
<tr>
<td><strong>Customer Service Department (US) Internal Sales Department (UK)</strong></td>
<td>T: +1 877 ASK ZEBRA (275 9327) E: <a href="mailto:clientcare@zebra.com">clientcare@zebra.com</a></td>
<td>T: +44 (0) 1628 556032 F: +44 (0) 1628 556001 E: <a href="mailto:cseurope@zebra.com">cseurope@zebra.com</a></td>
<td>T: +65 6858 0722 F: +65 6885 0836 E: China: <a href="mailto:order-csr@zebra.com">order-csr@zebra.com</a> All other areas: <a href="mailto:csasiapacific@zebra.com">csasiapacific@zebra.com</a></td>
</tr>
</tbody>
</table>

### Key:
- T: Telephone
- F: Facsimile
- E: E-mail
Glossary of Terms

Auto translation
Bar code interpretation in human readable characters.

Darkness
The print-head temperature defines the print darkness. The higher is the temperature, the darker is the printout. (thermal printers only)

Descender bars
Longer first and last bar in the EAN 13 bar codes.

Quiet zone
The empty place before and after the bar code symbol. This is necessary for the bar code reader to properly read the bar code.

Security
The definition of the control check-digit with some bar code types.
Numerics
12345\description, 77
13th, 85
2D, 77
2-digit, 88
2D-Pharmacode, 88
32-bit Windows, 12
32-bit Windows®, 8
5-digit, 88
7-bit ASCII, 82
8-bit, 81

A
A.Z, 82
About, 9, 31
Activate, 22
  Copy, 22
  Paste, 22
Activate button, 14
Activate the software, 14
Activation, 9
Addon, 88
Administrator, 12
Align, 89
Align Objects, 89
Align toolbar, 49, 89
All 128 Extended ASCII, 81
All EBCDIC, 82
All ISO, 82
Alt, 17, 21
  holding, 17
  pressing, 21
Alt + Backspace, 18
Alt + Shift, 18
Always, 35
Anker, 88
Area/object, 17
Arrange Icons, 31
Aspect Ratio, 81, 82
Auto, 86
Auto-identified, 39
Automatic Sizing, 37, 43
Auto-translation, 86
Aztec, 88

B
Backspace, 18, 21
Backspace key, 21
Bar
  Define button, 84
Bar code, 27, 51, 94
  select, 27
Bar Code Object, 68
  Define, 68
Bar Code Wizard, 77
BitMap, 91
Bitmap Windows, 67
BMP, 48, 91
Bookland, 88
Border Size, 82
Browse button, 80
C
Cancel button, 84
  clicking, 84
Captions, 29
Cascade, 30
CC-A/B, 88
CC-C, 88
CD, 12
CD-ROM, 12
Change, 62, 63
  Dithering Type, 63
  Speed, 62
Change Common Printer Settings, 62
Change Dithering Options, 63
Check, 85
Check Digit Tab, 85
Choose Arial, 45
Choosing, 21, 72, 78
  Open, 21
  Undo, 21
Clicking, 19, 22, 41, 84
  Cancel button, 84
  Finish button, 41
  OK button, 84
  Open button, 19
  Paste-link, 22
Close, 19, 31
Close All, 31
Close All Software Applications, 12
Codabar, 88
Codablock, 88
CODE 128, 88
Code 32, 88
Code 39, 88
Code 39 Full ASCII, 88
Code 39 Tri Optic, 88
Code 93, 88
Code Type, 77
Code Wizard, 77, 78, 79, 80
Code Wizard dialog, 68
Code128, 47
Code128 bar, 47
Code-39, 87
Codes, 26, 27, 29
Composite RSS symbologies, 88
CompuServer Bitmap, 91
Contact Information, 117
Contents, 8, 31, 51
  package, 8
Contents Provider, 17
Control Panel, 20
Copy, 22
  activate, 22
Create, 41
  New Label, 41
Create Date, 51
Create Variable Fields linked, 51
  Variables, 51
Ctrl, 17, 18, 21, 22, 88
  Holding, 17, 88
  pressing, 22
Ctrl key, 17, 89
  holding, 17
  use, 17
Ctrl+Enter, 94
Cut, 21

D
Darkness, 62
Data Format, 75, 79
Data Matrix, 82
Data View, 23
DataMatrix, 88
DataMatrix Bar Code, 82
Date, 74
Date Field, 74, 78
Date/time, 50
Define, 37, 39, 68, 69, 70
  Bar Code Object, 68
  Ellipse Object, 70
  Inverse Object, 70
  Label Dimensions, 39
  Line Object, 69
  Page Size, 37
  Picture Object, 69
  Rectangle Object, 69
  Text Object, 68
Define button, 47, 77, 84
  bar, 84
Define Label, 43
Define Script, 95
Define Setup Options, 13
Define Variable Name, 94
Define Variable Properties, 94
Del, 21
Del button, 22
Delete, 22
DEMO, 14
DEMO dialog, 14
Depending
  Windows, 32
Descender, 87, 119
Design toolbar, 25, 68, 91
  Use, 68
Design window, 25
Designing, 9
  Labels, 9
Details, 87
Details Tab, 87
DIB, 91
Display Grid, 24
Dithering, 63
  Open, 63
Dithering Type, 63
  Change, 63
Document1, 19
Document2, 19
Downloader, 29
  Use, 29
DUN-14, 88

E
EAN, 85, 87, 88
EAN 13 bar, 119
EAN.UCC 128, 88
EAN-13, 88
EAN-13 bar, 85
EAN-14, 88
EAN-8, 88
ECC Type, 82
Edit bar, 84
Edit Bar Code dialog, 47
Edit Bar Code Dialog Box, 84
Edit Memory Card, 29
Edit Objects, 89
Ellipse, 26, 27
Ellipse Object, 70
  Define, 70
Ellipse tool, 70
  selecting, 70
EMF, 91, 98
Enable, 84, 93
  Variable, 93
Enable/disable, 85
Enhanced Windows Metafile, 91
Enlarge/reduce, 67
Enter, 89
  press, 89
Enter Non-Changing Text, 44
Enter Time, 52
Error Correction Codes, 82
Exit, 21
Export, 20, 99
  Printer, 20, 99

F
F2, 18
F4, 21
FAQ, 116
FAX, 91
File menu, 19, 20, 21, 31, 41, 62, 63
Finish button, 39, 41, 43, 44, 47, 50, 51, 52, 68, 89, 93
  clicking, 41
Folder, 9
Follow, 13, 68
  onscreen, 13, 68
Font button, 86
Fonts/printers, 71
Format ID, 82
Frequently Asked Questions, 116
Full 128 ASCII, 81, 82

G
G3F, 91
G3N, 91
General, 84
General Tab, 84
GIF, 48, 91
Glossary, 119
  Terms, 119
Graphics Downloader, 29, 81, 114
Graphics Wizard, 80, 81
GreyMap, 91
Grid, 24
  Snap, 24
Group, 13, 88

H
Halftoning, 63
Holding, 17, 69, 70, 88, 89
  Alt, 17
Ctrl, 17, 88
  Ctrl key, 17, 89
Shift, 17
  Shift key, 69, 70
Human, 86
Human Readable Tab, 86

I
ICB, 91
Include EAN, 87
InfoGlyph, 88
Ins, 22
Insert Bar Codes, 47
Insert Pictures, 48
Install button, 13
Install Overview, 12
Install Printer Driver, 42
Installation/demonstration, 12
Installed, 12, 13
Software, 12
Intercharacter, 87
Interface Reference, 9
Inverse, 26, 28
select, 28
Inverse Object, 70
Define, 70
ISO, 56
ITF 14, 88
ITF 16, 88

J
J2K, 91
JP2, 91
JPC, 91
JPE, 91
JPEG, 48, 91
JPEG Bitmap, 91
JPEG2000, 91
JPEG2000 Code Stream, 91
JPG, 91

K
Keyboard, 17
Using, 17
Kix, 88

L
L, 82
Label, 9, 20, 39, 49
Designing, 9
Save, 49
use, 20
Label Dimensions, 37, 39
Define, 39
Label Orientation, 38
Select, 38
Label Setup, 20
Label Setup Wizard, 19, 32, 35, 41, 56
Label Stock, 36
Select, 36
Language, 30
Large Icons, 29
Leave, 41, 43
Page Size, 43
Wizard, 41
LEISURE.WMF, 48
liability, 2
Line, 26, 27, 50
Line Object, 69
Define, 69
Linear RSS symbologies, 88
Links, 23

M
Main Window, 16
Manual, 9
MaxiCode, 88
MaxiCode 2D Code, 83
MB, 12
RAM, 12
ME, 12
Menus Show Recently Used Commands First, 29
Merging, 93
Real Time Clock, 93
MicroPDF, 88
MicroQR, 88
Microsoft® Windows® 98 SE, 12
Mirror horizontally/mirror, 87
More windows, 31
Mouse Effectively, 17
Mouse Wheel, 17
Mouse Wheel support, 17
Move Objects, 89
MSI, 88
Multiline Variable, 94
My Documents, 19
My Labels, 19

N
New, 41
New Date Field, 51
New Label, 19, 41
Create, 41
New Time Field, 51, 52
Next, 52
Next button, 13, 35, 36, 37, 38, 42, 43, 51, 68, 81, 93
Non-RFID, 58
Normal View, 23
NT, 12
O
Object menu, 26, 27, 28
OK, 9
OK button, 47, 62, 63, 84
clicking, 84
OLE DB, 12
Support, 12
Online Support, 116
Onscreen, 13, 68
Follow, 13, 68
Open, 19, 21, 62, 63
choosing, 21
Dithering, 63
Options, 62
software, 41
Open button, 19, 48, 69
clicking, 19
Open dialog, 48, 69
Opentype, 67
Optimize, 114
Printing Speed, 114
Options, 62
Open, 62
Overview, 41, 50, 55

P
Package, 8
Contents, 8
Page Dimensions, 43
Page Size, 37, 43
Define, 37
Leave, 43
Part>, 77
Paste, 21, 22
activate, 22
Paste Link, 22, 23
Paste-link, 22
clicking, 22
PBM, 91
PC, 9, 12, 73, 74, 78, 79, 99
PCX, 48, 91
PDF 417, 81
PDF 417 2D Code, 81
PDF-417, 88
Pentium-based, 12
PGM, 91
Pharmacode, 88
Picture, 26, 27, 51, 94
Picture Object, 69
Define, 69
PIX, 91
Plessy, 88
PNG, 91
Portable Network Graphics, 91
Portable Pixmap, 91
Postnest-62, 88
Postnet-32, 88
Postnet-37, 88
Postnet-52, 88
Post-processors, 8, 95
PPM, 91
Prefix, 52, 76, 80
Setting, 76
Prefix/suffix, 76, 80
Pressing, 21, 22, 88, 89
Alt, 21
Ctrl, 22
Enter key, 89
Shift, 21, 22
Shift key, 88
Preview, 19, 73, 74, 78, 79
Previewing Labels, 9
Print, 27, 28, 55, 57, 62
RFID, 55
Print bar, 85
Printer, 20, 35, 42, 62, 99
Export, 20, 99
Select, 35, 42
Printer Objects, 26
Printer Settings, 20, 62, 63
Printers
Real Time Clock, 92
Printing Speed, 114
Optimize, 114
Program, 26, 58
Program Group, 13
Programming, 28
Properties button, 35
PXM, 91

Q
QR, 88
Quick Launch, 13

R
Radio Frequency Identification, 55
RAM, 12
MB, 12
Read, 58
Read Source, 79
Real Time Clock, 73, 76, 79, 80, 93
merging, 93
surrounding, 93
Recent Windows, 12
Recently Used Files, 21
Rectangle, 26, 27
Rectangle Object, 69
Define, 69
Rectangle tool, 69
selecting, 69
Redo, 21
Refer
Related Topics button, 50
Related Topics button, 35, 50
Resize Objects, 90
RFID, 55
printing, 55
prints, 58
programs, 58
RFID Tag
view, 57
RFID-enabled, 75, 79
RLE, 91
Rotate Objects, 91
Rotated, 38
Rounded Rectangle, 27
RSS, 77, 88
RSS Expanded, 88
RSS Limited, 88
RSS14, 88
RSS14 Stacked, 88
RSS14 Stacked Omnidirectional, 88
RTC, 73, 74, 78, 79, 92, 93
Run Installation, 12

S
Sample Graphics, 48
Save, 19, 49, 62, 63
Label, 49
selecting, 63
Save As, 19
Screen, 71
Text Wizard, 71
Select, 22, 25, 26, 27, 28, 35, 36, 38, 42, 57, 63, 69, 70, 86, 93
Bar Code, 27
Ellipse, 27
Ellipse tool, 70
Inverse, 28
Label Orientation, 38
Label Stock, 36
Line, 27
Picture, 27
Printer, 35, 42
Rectangle, 27
Rectangle tool, 69
Save, 63
Select, 26
Text, 27
time Field, 93
Select Objects, 88
Select Stock window, 43
Select Type, 72, 78
Variable Bar Code, 78
Variable Text, 72
Select Variable, 51
Select Variable Field, 51
Selected RFID Tag, 79
Set, 76
Prefix, 76
Settings/All Users/Application Data/Zebra
Technologies, 32
SETUP.EXE, 9
Shift, 17, 21, 22
Holding, 17
pressing, 21, 22
Shift key, 21, 69, 70, 88
hold, 69, 70
press, 88
Shortcuts, 18
Small Icons, 29
Snap, 24
Grid, 24
Software, 8, 12
Installation, 13
Software Edition, 12
Speed, 62
  Change, 62
SSCC, 88
Stacked, RSS14 Stacked Omnidirectional, 88
Standard toolbar, 25, 41, 62, 63, 64, 99
  Use, 64
Start > Programs, 9
Start menu, 13
Start the software, 14
START.EXE, 12
Stock Type, 36
Structure, 83
Structured bar, 83
Suffix, 76, 80
Suffix Options, 52
Support, 12, 116
  OLE DB, 12
Supported Bar Code Types, 88
Supported Graphics Formats, 91
Surrounding, 93
  Real Time Clock, 93
Symbology, 84
System folder, 32

T
Tab, 17
TARGA, 91
Targa Bitmap, 91
Technical Support, 9
Terms, 119
  Glossary, 119
Test, 20
Test Print, 20, 98
Test Print Labels, 98
Text, 25, 27, 94
Text Object, 68
  Define, 68
Text Toolbar, 25, 44, 67
  Use, 67
Text Wizard, 51, 71, 72, 73, 74, 76
  screen, 71
Text Wizard dialog, 68, 93
TGA, 91
TIF, 91
TIFF, 91
TIFF Bitmap, 91
Tile, 30
Time, 52, 73
Time Field, 73, 79, 93
  Select, 93
Time Variable Fields, 51
Toolbars, 17, 29, 91
Toolbox, 25, 26, 27, 28, 44, 47, 48, 49, 50, 51, 52, 56,
  57, 66, 68, 69, 70, 88, 93
  Use, 66
True type, 29, 67, 75, 79
Two-dimensional, 88
Type SAMPLE, 44
Type1, 67
Types, 88
Typographical Conventions, 9

U
UHF, 56
Undo, 21
  choose, 21
Unique, 75, 79
UPC, 88
UPC bar, 85, 87
UPC Case Code, 88
UPC-A, 88
UPC-E, 88
Use, 17, 20, 29, 64, 65, 66, 67, 68, 73, 74, 78, 79, 114
  Ctrl key, 17
Design Toolbar, 68
Downloader, 29
Label, 20
Standard Toolbar, 64
Text Toolbar, 67
Toolbox, 66
Variable Toolbar, 65
ZebraDesigner Font, 114
Use Alignment Tools, 49
Use Drawing Tools, 50
Use Existing Variable, 65
Use Label Setup Wizard, 35
Use Prefix, 52
User, 43
User Guide, 9
Using, 17
  Keyboard, 17
Using Printer Real Time Clock, 93

V
Variable Bar Code, 78
  Select Type, 78
Variable Name, 94
Variable Selection, 81
Variable Text, 72
  Select Type, 72
Variable Toolbar, 25, 65
  Use, 65
Variable Wizard, 51, 94
Variables, 51, 65, 93
  Create Variable Fields linked, 51
  Enable, 93
VDA, 91
View, 57
View Menu, 89, 91
VST, 91

W
Welcome, 8
Welcome Wizard, 32
Windows, 13, 19, 22, 32, 35, 114
  depending, 32
Windows 2000, 8
Windows 98 SE, 8
Windows application, 22
Windows Bitmap, 91
Windows dialog, 32
Windows ME, 8
Windows Metafile, 91
Windows NT, 12
Windows NT 4.0, 8
Windows Server 2003, 8
Windows XP, 8

Wizard, 35, 37, 39, 41, 77
  leave, 41
WMF, 48, 91, 98
Workarounds, 116
WYSIWYG, 75, 79

X
X-Expansion, 84
XP, 12

Z
Zebra, 51, 75, 79
Zebra Programming Language, 95
Zebra Technologies Corporation, 117
Zebra Web site, 116
ZebraDesigner Font, 80, 114
  use, 114
ZebraDesigner for mySAP
  Install Overview, 12
ZebraDesigner for mySAP CD, 8, 12
ZebraDesigner Printer Driver, 37
Zoom, 23, 24
Zoom dialog, 24
Zoom In, 18, 23
Zoom Out, 18, 23
ZPL, 95